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Updates 

Change highlighting will be employed for all revisions. Where new or changed information is presented section 
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Suggestion / Problems 

This manual provides documentation relating to products to which you may not have access, or which may not be 
licensed to you. For further information on which products are licensed to you please refer to your license conditions. 
 
Visit our website at https://www.aveva.com 

 
Disclaimer 

1. AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses. 

2. AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of 
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any 
special, indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered 
by the user, including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created 
by the AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, 
tort (including negligence) or otherwise. 

3. AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the 
performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's 
claim is brought. 

4. Clauses 1 to 3 shall apply to the fullest extent permissible at law. 

5. In the event of any conflict between the above clauses and the analogous clauses in the software licence under 
which the AVEVA software was purchased, the clauses in the software licence shall take precedence. 

https://www.aveva.com/
https://www.aveva.com/
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Copyright Notice 

All intellectual property rights, including but not limited to, copyright in this Training Guide and the associated 
documentation belongs to or is licensed to AVEVA Solutions Limited or its affiliates.  
 
All rights are reserved to AVEVA Solutions Limited and its affiliates companies. The information contained in this 
Training Guide and associated documentation is commercially sensitive, and shall not be adapted, copied, reproduced, 
stored in a retrieval system, or transmitted in any form or medium by any means (including photocopying or electronic 
means) without the prior written permission of AVEVA Solutions Limited. Where such permission is granted, AVEVA 
Solutions Limited expressly requires that the Disclaimer included in this Training Guide and this Copyright notice is 
prominently displayed at the beginning of every copy that is made.  
 
Licenses issued by the Copyright Licensing Agency or any other reproduction rights organisation do not apply. If any 
unauthorized acts are carried out in relation to this copyright work, a civil claim for damages may be made and or 
criminal prosecution may result.  
 
AVEVA Solutions Limited and its affiliate companies shall not be liable for any breach or infringement of a third party's 
intellectual property rights arising from the use of this Training Guide and associated documentation.  
 
@AVEVA Solutions Limited 2019 
 

Trademark Notice  

AVEVA™, AVEVA Everything3D™, AVEVA E3D™, [AVEVA Tags], Tribon and all AVEVA product and service names are 
trademarks of AVEVA Group plc or its subsidiaries  
 
Use of these trademarks, product and service names belonging to AVEVA Group plc or its subsidiaries is strictly 
forbidden, without the prior written permission of AVEVA Group plc or AVEVA Solutions Limited.  Any unauthorized 
use may result in a legal claim being made against you.  
 
Fluent is a trade mark of Microsoft Corporation.  The Fluent user interface is licensed from Microsoft Corporation by 
AVEVA and use of the Fluent trade mark is strictly forbidden  
 
All other trademarks belong to their respective owners and cannot be used without the permission of the owner. 
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1 Introduction 
This document is intended to provide an overview of AVEVA Everything3D™ 3.1 and the features introduced.  
 

1.1 Introducing AVEVA Everything3D™3.1 
AVEVA Everything3D™ 3.1 (AVEVA E3D™ 3.1) is an innovative 3D design product from AVEVA covering the needs of 
Plant and Marine industries.  
 
AVEVA E3D 3.1 provides a platform that enables lean construction principles to be adopted, increasing quality and 
speed of execution throughout the entire project. This is achieved through advanced usability for all design tasks which 
improves productivity by utilising latest technologies and best in class User Experience to enable innovative and ever 
more efficient project execution processes. This is demonstrated by the clean and intuitive user interface of the 
product that encourages graphical centric modelling and interaction. 
 
AVEVA E3D 3.1 is based upon a proven platform of technologies used to support a wider family of products; supporting 
common capabilities such as multi-user, distributed and concurrent access to the design model, and the comparison 
and update of information. This allows global teams to collaborate in building fully detailed models, from which 
construction-ready drawings and BOMs can be automatically generated. 
 
AVEVA E3D 3.1 contains the following principal modules:  

• Model An interactive 3D design environment. 

• Draw Facilitates the production of scaled, annotated drawings from the 3D Model. 

• IsoDraft Used in the production of piping isometrics. 

• Catalogue Used to define and configure Project Specifications and Standards. 

As part of an integrated product solution, AVEVA E3D 3.1 may integrate with AVEVA Engineering and Schematics 
products through capabilities such as the Piping Integrator feature. Further, AVEVA E3D 3.1 may be integrated with 
AVEVA NET, epitomised by the Design in Context feature that allows the direct interrogation of the AVEVA NET 
Dashboard in the Model and Draw environment. 
 
System administration and configuration, together with catalogue and specification capabilities, are provided by the 
AVEVA Catalogue and separate AVEVA Administration™ products respectively.  
 
AVEVA E3D 3.1 has been designed from the outset to be compatible with AVEVA PDMS and Hull & Outfitting 12.1.SP5 
and it uses the same database and data management technology, enabling the two products to be used in conjunction 
on operational projects. 
 
AVEVA E3D 3.1 introduces a series of new developments for both Marine and Plant industries: 

• Cross-discipline Space Management application. 

• Introduction of the Hull Structural Design application. 

• Support for large co-ordinate modelling. 

• Improved integration of Laser data, including the introduction of Solid Point Cloud rendering and data 
highlighting. 

• Multiple model enhancements to aid the design workflow in Plant and Marine industries including allowance 
for Grid Format positioning. 
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• Draw Improvements (incl. combination of Draw features and canvas in the Model module). 

 Hull Design 

The Hull Design application, for Marine industries, facilitates the modelling of the hull steel design; primarily in ships 
and other floating structures. The hull steel model is highly topological and benefits from the model being formed by 
common references, i.e. surfaces, curves and points. Hull model properties can be inherited from information added 
to a functional arrangement i.e. space, area and curve arrangements. Hull specific drawings are created with 
specialized functions in the Draw module, now integrated as part of the Model module. 
 

The main characteristics of the Hull solution are described below. 
 

1.1.1.1 Hull Modelling in a context 

• Easy modelling of Common Reference Models. 

• Easy update to account for changes. 

A hull modelling project is characterized by a high degree of change, e.g. when moving a complete deck, and there is 
a need for all dependent structures to easily adapt. To support this in AVEVA E3D, the hull model is defined by 
topological references. Robustness of the topological references is promoted where the Common Reference Model 
(Surfaces, planes, curves, points and grids) is used. 
 

 
 

The modelling of the Common Reference Model in AVEVA E3D is completed using the introduced intuitive and 
interactive tools; allowing complex shapes to be easily modelled. 
 

 



AVEVA E3D™ 3.1 User Bulletin Page 13 of 115 

 

 

 

 
 

1.1.1.2 Fast Hull Modelling 

• Easy and fast modelling. 

• Topological models with stored definition data. 

• Easy update to account for changes. 

The modelling of a hull panel automatically, from a given location, derives its shape from the surrounding elements 
and can be easily modified with new or altered bounding elements. Detailing of the panel, such as adding seams, holes, 
cutouts and brackets, is then completed through a one-click philosophy; resultant hull components are visualized in 
the canvas with a minimum of user interaction. 
      

    
 

The defined hull components are further detailed by using the provided tools and functions e.g. the Model Properties 
Grid. 
 
All definition data describing the panel and its components, with topological references, are stored in the database. 
Changes to the panel, or to the surrounding elements, can be easily accomodated through simple recreate operations. 
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1.1.1.3 Symmetry and Repetitions 

• Symmetric models. 

• Repetition with Cloning. 

• Easy change of multiple models simultaneously. 

A ship model contains many repetitions: structure elements that are similar in nature but vary in shape depending on 
where it is located. The topologically defined panel can easily be copied or cloned by adjusting the definition data of 
the panel e.g. changing the location. 

 

 
 
Furthermore, if cloning a panel, a connection is established between the panels and between the panel components. 
This connection is used when making changes, propagating the made change to all the connected panels. However, 
specific changes can still be made by breaking the connection on individual hull components e.g. when adding or 
changing a specific hole in one of the cloned panels. A ship model is likely to contain a number of symmetric elements; 
identical, or near identical, structures are typically modelled on both the portside and starboard. This consideration is 
also supported by the cloning concept. 
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1.1.1.4 Hull Structural Design Models and Deliverables 

• Hull Models detailed for Class Approval. 

• Drawing deliverables. 

The AVEVA E3D 3.1 Hull application supports the modelling of hull with detailing up to class approval stage. The ship 
model can be used with the AVEVA E3D 3.1 outfitting modules to create a complete model for this early phase of the 
ship project. The drawing deliverables are created in the Draw module or model application which has been updated 
to support the necessary marine drawing types i.e. general arrangement, body plan and shell expansion. 
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 Combined Model and Draw 

• Combined 2D and 3D environment in the same module. 

A key aspect of AVEVA E3D 3.1 is the possibility to utilise a selection of key E3D Draw features in the E3D Model 
module. This allows all users to create, view and modify drawings during the modelling design phases. Changes in the 
model can be seen in the drawing directly as the model is updated.  

 

 

 Space Management 

The Space Management application, for both Plant and Marine industries, facilitates arrangement design including the 
definition of spaces, areas and curves with the possibility to define functional data to specialize for a specific design 
purpose. The arrangements may be used to coordinate and support design activities with geometry data and 
functional properties. 
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1.1.3.1 Common Reference Model 

• Easy modelling of Common Reference Models. 

• Primitive modelling.  

The spatial modelling capabilities in the Space Management application is based on the principle of an envelope and 
a closed volume that is subdivided automatically, and refined with merge and boolean operations like add and 
subtract. The creation of an initial envelope and subsequent space subdivisions are typically created by references to 
the Common Reference Model i.e. surfaces and planes. 
 
To support a typical plant scenario the Space Management application further supports the use of primitives combined 
with planes in grid or absolute coordinates to subdivide a space further. 

 

 
 
1.1.3.2 Modelling Space Arrangements 

• Easy modelling through automatic subdivision. 

• Topological model responding to model changes. 

• Functional properties. 

• 3D coordination. 

Space arrangements are modelled by an automatic subdivision of an envelope and further refined by merge and 
boolean operations, i.e. adding or subtracting primitives or other volume elements. The result is a coherent space 
model without any accidental void spaces. The definition data and the referencing into the Common Reference Model 
is stored with the arrangement to support ease of modification. Several space arrangements can be created, for 
different purposes, within the same volumetric area of the project e.g. for painting area calculation, compartmentation 
or 3D coordination. Each arrangement has a set of properties, pre-defined or user-defined, to support the functional 
purpose. 
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Each space can be queried for properties and be used in volumetric queries such as ascertaining information inside 
the space. The result can be used for coordination and for analysis in supporting a designer. 
 
1.1.3.3 Analysis using Space Arrangements 

• Volumetric queries. 

• Exact geometrical calculations.  

• Storing analysis results in a databank for further processing and follow up.  

• Reporting. 

The volumetric queries, resulting in a selection of models, can be used for various analysis purposes e.g. calculations 
on volumes, areas and weight and center of gravity.  All model elements, fully or partly within the space, are included 
in the calculation, however only the parts of a model element that is inside the space are considered. The result of a 
calculation can be stored in an analysis databank (new in AVEVA E3D 3.1) and can be used for reporting or to integrate 
with AVEVA Engineering.  
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The Report Tool is used for reporting and some example report templates are delivered with the installation. 
 

 
 

1.2 The User Bulletin 
The aim of the User Bulletin is to provide an overview of the main functional differences between AVEVA E3D 3.1 and 
AVEVA E3D 2.1. 
 

Please refer to the AVEVA E3D 2.1 release documentation and collateral for further information on the 
capabilities introduced by the AVEVA E3D 2.1 product. 

 Using this Bulletin 

Certain text styles are used to indicate special situations throughout this document.  
 
Additional information notes and references to other documentation will be indicated in the styles below. 

 
Refer to other documentation. 

 
Additional information. 

 

1.3 AVEVA Experience 
AVEVA Experience™ (https://www.aveva.com/experience) provides an effective and easily accessible way to gain 
hands-on experience of AVEVA E3D, wherever the user is located. For employers, it makes it easier to train and upskill 
engineers and designers. 
 
Once registered, the user will have the opportunity to go through an extensive set of training modules on core aspects 
of AVEVA E3D, including training exercises and 'how-to' videos. These modules will highlight the key differences 
between AVEVA PDMS / AVEVA Hull & Outfitting and AVEVA E3D. The user will also be able to work with a Cloud-
hosted deployment of AVEVA E3D, including a sample set of project data. 
  

https://www.aveva.com/experience
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2 AVEVA Everything3D™ 3.1 
The AVEVA Everything3D™ 3.1 (AVEVA E3D™ 3.1) release, usually supplied by download from a secure website, self-
installs using standard Microsoft installation procedures. Please contact your local AVEVA office if a DVD installation 
is required. As found with other AVEVA products, the release is typically installed to individual PCs with a Microsoft 
Windows operating system, with the license server and file installed to a networked Microsoft Windows server. In 
addition, the project data is typically located on a separate server. 
 
AVEVA E3D 3.1 is a full release that may be run alongside and in conjunction with AVEVA PDMS and Hull & Outfitting 
12.1.SP5 (Fix Release 15 onwards). 
  

AVEVA E3D 3.1 may also be used in conjunction with other products in the AVEVA product portfolio – please 
refer to Section 2.5. Compatibility with other AVEVA Products. 

 
AVEVA E3D 3.1 requires the use of AVEVA Administration: this product is distributed, installed and licensed separately 
and may also be used for AVEVA PDMS, Hull & Outfitting, Engineering and Schematics products. 
 

2.1 Workstation Configuration 
The following configuration is recommended in the use of AVEVA E3D 3.1. A 64-bit operating system is required for 
the installation of AVEVA E3D 3.1 and for the visualisation and use of laser data in the application. 
 

Configuration Recommendation 

Operating System(s) 
Windows® 10 (64-bit) (version 1709 or higher).  
Microsoft .NET Framework 4.7.2. (Supplied with AVEVA E3D 3.1 and installed if necessary). 

Processor Type / Speed Intel x86 or x64 compatible - CPU with high performance in each processor core. 

Memory 16 GB of high-speed RAM 

Hard Disk Storage 

A full installation requires approximately 1GB of drive space.  
 
In addition, extra capacity is usually required for local storage and data; this may be used 
for the database cache where the Database Cache Service is employed. 
 
The use of two SATA-300 RAID HDDs is recommended where projects are stored on the 
local machine. The product has also been verified with solid state HDDs. 

Display 
High resolution widescreen displays recommended (1920 x 1200); dual screens also 
supported.  

Graphics Card 

NVIDIA Quadro, AMD FirePro™ or similar.  

 
Please refer to Section 2.2 Graphics Cards for further information. 

*1 AVEVA does not support the installation of E3D 3.1 software and\or Projects on to disk volumes with Short\8.3 file name format disabled. Please ensure that 
Short\8.3 file name format is enabled on all relevant volumes before installation.  

 

For further information regarding IT Configuration please contact the local AVEVA Support Office. Recommended 
/ supported hardware and software configurations are constantly subject to review; please consult the AVEVA 
support web pages for the latest recommendations. 
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2.2 Graphics Cards 
AVEVA E3D 3.1 requires 3D graphics hardware, capable of running DirectX 12, to ensure optimum performance for 
both design and drafting. DirectX 12 is included as an integral part of the Windows 10 operating systems.  
 

 

AVEVA strongly recommends that appropriate hardware is 
used for AVEVA E3D 3.1. If appropriate graphics hardware is 
not detected on entry, AVEVA E3D 3.1 may still be used but a 
warning will be given and certain graphical effects, including 
the use of laser data, limited. 

 
Following extensive testing of current market Graphics Cards and AVEVA E3D 3.1, a recommended configuration is 
summarised in the table below. 
 
 Desktop Laptop 

Graphics Card 

• NVIDIA® Quadro® P2000 or P2200 

• NVIDIA® Quadro® M2000 

• AMD FirePro™ WX5100 

• NVIDIA® Quadro® P2000 

• NVIDIA® Quadro® M2000M or M2200 

• NVIDIA® Quadro® T1000 

DirectX Support • DirectX 12 (Shader Model 5.1). • DirectX 12 (Shader Model 5.1). 

 
Where laser data is utilised, the Graphics Card Memory allocation is an important consideration as this is further 
exploited in the visualization and manipulation of laser data (incl. HyperBubble™). Note that the system will post 
an error message on entering the HyperBubble where the GPU memory is less than 1GB. 

 
AVEVA strongly recommends that clients should test their chosen card or laptop in their own environment before 
purchase. 

 
Availability and support of graphics cards changes frequently; a full updated list of graphics cards that have been 
verified with AVEVA E3D 3.1 is available via the IT Configuration area of the AVEVA Support Site 
(https://support.aveva.com). 

 
To ensure the optimal performance of the graphical memory, i.e. when utilising laser data, it is recommended that the 
Physical Processor is altered (where employing a NVIDIA graphics card). 
 

 

Using the NVIDIA Control Panel, setting a GPU allows an 
increase in PhysX processing and may improve overall 
performance. 

 

https://support.aveva.com/
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2.3 Server Configuration 
The following configuration is recommended in the use of AVEVA E3D 3.1 with a server configuration. A 64-bit 
operating system is required for the installation of AVEVA Everything3D™ 3.1. 
 

Operating System(s) 

• Windows® Server 2019 (version 1809). 

• Windows® Server 2016 (version 1607). 

• Microsoft .NET Framework 4.7.2. (Supplied with AVEVA E3D 3.1 and installed if necessary). 

Processor Type / Speed 
Intel x86 or x64 compatible - Modern architecture multiple core processors recommended 
(AVEVA E3D 3.1 has been verified using a Server Machine with 4 core CPUs). 

Memory 
16 GB RAM.  
Additional RAM increases the caching capability and thereby the performance. 

Hard Disk Requirements 

The amount of disk space should be configured according to the customer's requirement 
based on the number and size of projects (incl. supporting laser data).  
 
To secure data and improve performance, the use of RAID 0+1 or 5 storage is recommended; 
15k rpm drives are preferred. 

File System 
NTFS  
For further information on NTFS, please refer to: https://docs.microsoft.com/en-us/windows-
server/storage/file-server/ntfs-overview.  

Network 
Gigabit Ethernet (GbE) LAN. 64-bit capable network adapter. The network should provide at 
least 1 Gb/sec for each workstation. Two or more network cards are recommended for 
increased performance and redundancy. 

 

2.4 Prerequisite for this Release (Products)  
The following products are required for the use of AVEVA E3D 3.1. 

 AVEVA Licensing™ 4.1.0 

AVEVA Licensing™ 4.1.0 or later and an appropriate License File is required for the operation of AVEVA E3D 3.1.  
 

AVEVA Everything3D™ 3.1 does NOT operate with AVEVA Flexman.  
 
Where upgrading from AVEVA Licensing System 2.0 or 3.0, the existing license file and logs will be preserved 
when upgrading. The version 2.0 license file will continue to work with the new ALS 4.1 server. 

 
For full details on the features of AVEVA Licensing System 4.1, please refer to the AVEVA Licensing System™ 4.1 
Release documentation and user guide. 

 AVEVA Client Cache Service™ 1.0.5 

The AVEVA Client Cache Service is designed for use on a LAN or WLAN network with full connectivity to the Database 
files and can make a considerable improvement to Dabacon database performance. The use of the Service is strongly 
recommended for all multi-user projects. The AVEVA Client Cache Service has been developed to produce an improved 
performance when reading data over ‘high’ latency networks by minimizing traffic. 
 
The AVEVA Client Cache Service stores a copy of the read project data on the local disk which improves performance 
where there is repeated reading of project data across a computer network. The service operates by a data request 

https://docs.microsoft.com/en-us/windows-server/storage/file-server/ntfs-overview
https://docs.microsoft.com/en-us/windows-server/storage/file-server/ntfs-overview
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being sent to the local Cache folder to retrieve the required Data (Database Page). If the data is not within the Cache 
folder, a Data Request is sent across the network to the central server to retrieve the required data. Likewise, data 
that is unchanged since it was previously read is retrieved from the local Cache whereas Data that has changed in the 
Database must be read again from the central Database file. Similarly, data that must be written to a Database file 
must still be written to that identified file. 
 

 

The AVEVA Client Cache Service is installed with AVEVA E3D 3.1 and may be configured or disabled using the AVEVA 
Cache Service Configuration application. The prompted form, seen above, enables an Administrator to configure the 
caching threshold level to avoid the local hard drive being filled. 
 

The Default is to stop caching on the Hard Drive on becoming 80% full.  When full, data is continued to be 
delivered where already cached but no further data is cached until more space is made available. The Cache 
persists data locally between sessions – thereby, very often, the start-up will be quicker. 

 
To ensure the performance benefits of the service are realized, Microsoft Message Queuing (MSMQ) must be 
enabled. This is achieved using the Windows Components feature of Windows Control Panel > Add or Remove 
Programs. 

 
For full details, please refer to the AVEVA Everything3D™ 3.1 Installation Guide. 

 Microsoft® Software 

The following Microsoft products are required to support the operation of AVEVA E3D 3.1. 
 
2.4.3.1 Microsoft Office & Fonts 

AVEVA E3D 3.1 requires Microsoft Office 2016 (or later) to ensure the full function of product features. Please note 
the following: 

• Optimum operation of the AVEVA Design Platform GUI requires Arial Unicode MS font, supplied with Microsoft 
Office and also with Microsoft Office Visio (Please note that this font is not available in Office 2016 by default). 

• The layout and display of forms and the general user interface may also be adversely affected if the screen font 
size is not set to the smallest size.  

AVEVA E3D 3.1 has been verified with Microsoft® Office 365. 
 

2.4.3.2 Microsoft Internet Explorer 

Internet Explorer 10.0 or later is required to support AVEVA E3D 3.1 e.g. the Model and Draw Design in Context feature. 
 
2.4.3.3 Microsoft .NET Framework 

AVEVA E3D™ 3.1 uses Visual Studio 2016 and .NET 4.7.2 for .NET Customisation.  



AVEVA E3D™ 3.1 User Bulletin Page 25 of 115 

 

 

 

2.5 Compatibility with other AVEVA Products  
For full compatibility details, and for information about AVEVA E3D 3.1 compatibility with any later versions, please 
refer to the compatibility matrix. A full and up to date compatibility matrix can be found via compatability.aveva.com 
/matrix. 
 
The following AVEVA products are compatible with AVEVA Everything3D™ 3.1.0: 

• AVEVA Administration™ 1.7.0 (Fix Release 1). 

Note: This release supersedes all previous AVEVA Administration versions delivered with other AVEVA products. 

• AVEVA Applications Service™ 3.1.0. 

• AVEVA Bocad™ 3.2.1. 

• AVEVA Client Cache Service™ 1.0.5. 

• AVEVA Clash Manager™ 14.3.0. 

• AVEVA Diagrams™ 14.1.3 (Fix Release 4). 

• AVEVA E3D Documentation™ 3.1.0. 

• AVEVA E3D Insight 2.3.0 (Fix Release 1). 

• AVEVA Electrical™ 12.2.0 (Fix Release 1). 

• AVEVA Engage™ 3.4.1. 

• AVEVA Engineering™ 15.2 Fix.1. 

• AVEVA ERM 15.1.2 

• AVEVA GCD Creator 3.4.1 

• AVEVA Global Server™ 3.6.0 (Fix Release 1). 

Note: Includes separately licensed products AVEVA Global Hub and AVEVA Global Satellite. 

• AVEVA Hull & Outfitting™ 12.1.5 & associated products (Fix Release 15). 

• AVEVA NET Gateway for AVEVA IE&D 1.3.0. 

• AVEVA Implant-I 2.3.0. 

• AVEVA Implant-STL 1.5.0. 

• AVEVA Instrumentation™ 12.2.0 (Fix Release 1). 

• AVEVA Integration Service 1.6.0 (Fix Release 2).  

• AVEVA NET Workhub & Dashboard™ 5.1.7 

• AVEVA Open Steel 2.3.0. 

http://compatibility.aveva.com/matrix/
http://compatibility.aveva.com/matrix/
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• AVEVA PDMS™ 12.1.5 & associated products (Fix Release 15). 

• AVEVA PDMS-VPRM Gateway™ 5.7.0 (Fix Release 2). 

• AVEVA Pipe Stress Interface™ 3.1.0. 

Note: Compatibility is via a forthcoming release.  

• AVEVA Pipe Stress Interface - R2 ™ 3.1.0. 

Note: Compatibility is via a forthcoming release.  

• AVEVA PML Publisher™ 2.2.0 

• AVEVA Shared Services™ 3.5.0. 

• AVEVA Structural Analysis Interface 4.1.0. 

 
The following LFM products are compatible with AVEVA Everything3D™ 3.1:  

• LFM Server™ 5.2.0. 

2.6 Environment Variables 
AVEVA E3D 3.1 relies on the use of environment variables for various aspects of configuration, notably the location of 
folders for project databases and user workspace.  
 
When setting up a user’s environment, please bear in mind that Write access is required for folders such as 
AVEVA_DESIGN_USER and AVEVA_DESIGN_WORK. The installer uses default locations, for both the program files and 
these data folders, that are different from those used for PDMS / Hull & Outfitting. These were chosen to work better 
on Windows 10; additional dialogs enable the user to control them better. 
 
The defaults are: 
 
Work files C:\Users\<username>\AppData\Local\Temp\  
 
User files C:\Users\Public\Documents\AVEVA\USERDATA\ 
 
Environment variables are usually set up for AVEVA E3D by the program initialization (.INIT) file when running 
interactively or by using a batch (.BAT) file. 
 

Note that at AVEVA E3D 3.1 an optional feature is available whereby a customer may remove all the Project 
evars from the corresponding bat files apart from <proj>000 and ID (required to display a project in the Login 
form). On selecting the project and entering AVEVA E3D 3.1, the start-up process will look to the project and set 
up any required environment variables.  Where an evar is already set, the start-up process will leave that 
untouched, thus avoiding any unnecessary changes. 

 

2.7 Network 
AVEVA E3D 3.1 is best run on a network offering Internet access.  
 
The system will by default be set up to access the latest online version of the documentation from the AVEVA website. 
It is possible instead to install the documentation locally. It may be downloaded from the AVEVA Support website, 
currently: AVEVA Everything3D - Documentation 3.1.0. 

http://support.aveva.com/support/United_Kingdom/download_search.asp?/services/upgrades/ae3d/AVEVA_Everything3D-2.1-UPGRADES-WWW.asp
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2.8 Security considerations for Customer IT (On-premise deployments) 
AVEVA E3D (Dabacon) projects rely on good LAN connectivity and availability between: 

• User Workstations and the License Server. 

• User Workstations and the Dabacon Project Database Server. 

Note that some virus scanners can interfere with product access to Dabacon Databases. 

• User Workstations and Company Customisations (both PML [PMLLIB and PMLUI folders] and C# Addins). 

• User Workstations and any other servers for any bulk import / output of Dabacon project data. 

 
The IT department is responsible for ensuring that appropriate access is provided while protecting against Data-
sniffing. 
 
Frequent backups of the Dabacon Database server should be taken to protect against malicious deletion. 
 
There should also be good connection between User Workstation and AVEVA products online help. 
 
If IT policy is to restrict access to the world-wide web and the AVEVA help is inaccessible to end-users, then it is advised 
that copy the online help to a corporate location, updating it regularly, and set products to use online help from this 
location. 
 
User workstations should have the appropriate Operating Systems, processors, graphics cards, memory and hard disk 
storage as specified in the previous sections. 
 

2.9 Install 
Installations using setup.exe will install to C:\Program Files (x86)\AVEVA\Everything3D3.1 by default. The individual 
.msi files will use the drive with most free space by default.  
 
It is important that any files, including configuration files or sample data, that need to be updated by users are 
accessible for read, write etc. so they are not by default installed with the software. This is particularly important when 
installing in Program Files due to the introduction of User Account Control (UAC). In particular, this makes it important 
to ensure that files that need to be written are accessible by users without Administrator privileges. This applies to 
folders specified by environment variables such as AVEVA_DESIGN_WORK and AVEVA_DESIGN_USER. The AVEVA 
Everything3D™ installer has been designed to allow the separate definition of suitable folders, with different defaults. 
 

It is not recommended that any combination of AVEVA products are installed in the same folder because AVEVA 
does not guarantee runtime compatibility between Separate Products on different release cycles, and the 
uninstall of one of them subsequently damaging the other. 

 
During the install process a user can configure AVEVA Everything3D 3.1 to access a license server running a valid 
AVEVA E3D license. This well set an Environment variable that points to the identified license server. 

 
For further details, please refer to the AVEVA Everything3D™ 3.1.0 Installation Guide. This may be accessed 
from the start screen of the installation process or found within the E3D310 release folder. 
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2.10 AVEVA Projects 3.1 
As part of the install process for AVEVA E3D 3.1, a variety of standard model projects may be installed and thereafter 
used in the product.  The projects are also available as a separate download available via support.aveva.com.   
 
The sample projects have been extended and enhanced but wherever data matches the previous (AVEVA PDMS and 
Hull & Outfitting) sample model data, the same reference numbers and database numbers are used to ensure 
compatibility. 
 
A file, for example APS_Project_description.pdf, is included in each project folder giving brief details of the purpose 
and data included in that project. The Catalogue Project (ACP) provides example component data and specifications 
(Component Data). All data in the projects are provided as sample data only and should be verified prior to production 
use. 
 
AVEVA Projects 3.1 include: 

• A main catalogue sample project called ACP (AVEVA Catalogue Project). 

• Sample data projects called APS (AVEVA Plant Sample) and AMS (AVEVA Marine Sample).  

• Sample drawings are in the Draw format and Draw project libraries have been extended to support any new Draw 
capabilities at AVEVA E3D 3.1. 

• Additional data has been added to support the use and demonstration of Space Management and Marine (Hull) 
data. 

The AVEVA sample projects are regularly revised.  Please check the AVEVA Support Site (AVEVA Everything3D™ Fix 
Release History) frequently for updates.  

 
A detailed list of changes is included in the AVEVA E3D Projects 3.1 release documentation. 

 

2.11 AVEVA Everything3D™ – Documentation 3.1 
The AVEVA E3D 3.1 documentation includes the AVEVA Administration, Catalogue and Global product user guides.  
 
Documentation is available online so that it may be continually updated and remain current for any new functionality 
introduced through the life of the product. AVEVA Documentation 3.1 may also be downloaded separately for local 
installation.  
 

 

The documentation may be accessed via the top of the main product window, via the Project tab or via the 
context sensitive F1 key. 

 
The Documentation is presented via a Help Viewer, which comprises an Explorer style Contents list complete with 
Search function and a reading pane.  
 

2.12 Entering AVEVA Everything3D 3.1 
AVEVA Everything3D 3.1 may be accessed via the Windows Start menu or Start screen depending on the Windows 
Operating System being used. 

  

http://support.aveva.com/services/upgrades/ae3d/ae3dnews.asp
http://support.aveva.com/services/upgrades/ae3d/ae3dnews.asp
http://support.aveva.com/support/United_Kingdom/download_search.asp?/services/upgrades/ae3d/AVEVA_Everything3D-2.1-UPGRADES-WWW.asp
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The Login form is displayed. 

 
The Project images may be set by placing an image (.png) named <project> within the <project>dflts folder. The 
recommended image size is 600x600.   

 
From the Login form a project may be accessed by selecting the identified Project tile prior to entering the required 
login information and clicking on the desired module. 

  

 

 

  

2.13 Project Configuration 
The following sections note recent changes to the supporting AVEVA Administration product and how they aid the 
configuration and use of AVEVA E3D. 
 

For more details please refer to the AVEVA Administration Release Letters and the Administation and Lexicon 
User Documentation. 

 UTC Date & Time 

AVEVA Administration (1.6) stores the UTC date time in addition to the local date time on both sessions and stamps 
when they are created. AVEVA E3D 3.1 utilises UTC date and time to ensure that updates are shown correctly 
sequenced across time zones.  
 
A project wide UTC switch has been introduced to control which date format is returned when either the session date 
or stamp date is queried. The UTC switch controls the output of a ‘Calculated local date time’ as the Session Date Time, 
where the Calculated local date time is the sum of the UTC date time when the session is saved and the current time 
zone bias. This allows interoperability for session dates with earlier AVEVA products e.g. PDMS / Hull & Outfitting 12.1 
SP5 
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UTC switch default states: 
ON for any new project created with, and OFF for any existing projects accessed with, Administration 1.6 

 
AVEVA recommends that once the UTC switch has been enabled, it is never disabled. 

 
If there is a requirement to copy an existing project that has UTC OFF and maintain this setting in the copy, since 
the starting point is to create a new project with either Make or Project Creation Wizard, this will see the new 
project created with UTC ON. Once the replication is complete the copied project will need to be switched to UTC 
OFF.  

 
Global Projects: As the Calculated Local Date Time depends on the current time zone, it is possible that the first 
session saved after the UTC switch is turned on could occur before the last session saved when the switch was 
off. To prevent this a gap of up to 24 hours (depending on the time separation of locations) is required between 
turning on the UTC Switch and saving the first (UTC) session.  

 Configuration Databases 

With the release of the supporting AVEVA Administration the Configuration Database has been introduced to move 
external reference data into project(s). 
 
In the installation folder of AVEVA E3D the databases folder contains two database files: 9100 and 9101 (C:\Program 
Files (x86)\AVEVA\Everything3D3.1\databases). These are DICTIONARY and CONFIGURATION Databases respectively. 
 
The supplied Databases are automatically included in any new project created and are referenced by AVEVA products 
in any module without the need to add them to the MDBs within the project. The DICT DB contains a set of KEYs, each 
Key representing a specific data type and the CONF DB contains a value applied to the key. An example might be a 
UNITs key with the value set to mm. 
 

The AVEVA supplied DICT and CONF Database files cannot be accessed or edited by customers. 
 

2.13.2.1 Customer Preferred Values 

It is noted that many customers have common data e.g. Piping CATA DB or PADD DB with corporate backing sheets 
and preferred symbols. These Databases are often stored in a master or corporate project and become foreign 
reference Databases in many design projects. Within each design project specific piping CATA DBs and PADD DBs are 
added to ensure the project has the specific design requirements. 
 
It is expected that customers will similarly create a master or corporate CONF DB in which they set the preferred values 
to overwrite one or more of the AVEVA default values and that this CONF DB is referenced by a design project. 
 
The design project may also have its own CONF DB to accommodate specific project requirements and this will be 
used to overwrite any AVEVA default values or any of the corporate CONF DB default values. 
 

Customers who create CONF DBs must add these to the MDBs within the project. 
 

2.13.2.2 Configuration in AVEVA E3D 

 
Users of AVEVA E3D 3.1 (or AVEVA Engineering) can see the configuration values via the Configure form 
accessed via the Standards button within the Configure group of the MANAGE tab.  
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Unless the user is a member of the appropriate Team, the user has read-only access. If required, a CONF DB may 
be created and assigned to a specific User to allow individual engineers or disciplines to utilise their own values 

 Additional (Engineering) Units 

Further Engineering units have been introduced via the AVEVA Administration product to support the interoperable 
use of AVEVA E3D and AVEVA Engineering.   
 
There are new Dimensions and Units of Measure:  
 

Cable (core) size: Reactive Power Noise  

• Kcmil 

• AWG 

• mm2  

• VAr  

 

• dBA 

 

 PML Pseudo 

AVEVA Administration (Lexicon) has introduced support for PML pseudo attributes with configuration for PML 
functions that will be called to set or retrieve values. Including such a UDA in the EXPCOL for a Dbview enables full 
PML2 functionality to be used.  
 

Please note that the use of PML in DBviews should be considered with care regarding performance impact.  
 

 Expression Query for Backref  

An introduced expression syntax supports a qualified backref to return the specific back reference for a UDA:  
 
Backref(attname :UDAname) 
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 Text Arrays 

Utilising the supporting AVEVA Administration product (Lexicon) a text array may now be used to define a UDA or 
attribute. 

 5000 Databases 

Projects created for use with AVEVA Everything3D 3.1 can now have 5000 DBs in an MDB. 
 
To enable this, the project is required to be upgraded using AVEVA Administration (1.7.0). 

• Enter Admin module, expunging any dead users and then LOCK the project. 

• Type the following command: 

DBUPGRADE PROJECT TO LATEST OPTION CONFIRMED 

• Unlock the project. 

 

2.14 Large Co-Ordinates 
In earlier versions of AVEVA E3D and AVEVA PDMS / Hull & Outfitting Model applications the extents of a primitive’s 
bounding box entry in the spatial map was limited in x, y, z world coordinates to +-100km. At AVEVA E3D 3.1 changes 
have been made to remove this limit so that primitives may be positioned beyond x, y, z world coordinates +-100km.  

 Compatibility with AVEVA PDMS / Hull & Outfitting 12.1.SP5 

Spatial maps built in AVEVA E3D 3.1 may be incompatible with AVEVA PDMS / Hull & Outfitting 12.1.SP5 and vice versa 
for elements positioned greater than +-5km from the origin. This can be resolved by using the command MAP 
CHECK/BUILD. The MAP CHECK/BUILD command will ensure that the spatial map is compatible in the following ranges: 

• Spatial map entries for xyz < +-5km will be compatible and not require a MAP BUILD. 

• Spatial map entries +-5km < xyz < +-100km will require a MAP BUILD going backwards/forwards between products. 

• Spatial map entries xyz > +-100km will not be compatible with 12.1.SP5. 

2.15 Search 

 Search via Explorer 

Access to the Search form has been extended to be made available from the (Model) Explorer. 

 

     

 Redesigned Search form 

The Search form has been revised at AVEVA E3D 3.1 with the following improvements: 

• Search (incl. number of elements found) and reset functions moved to the top of the form. 

• Able to view search result in a collection (via link).  
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• Additional search tools toggle button is used to manage the collapsible search options form. 

If a search result is more than 1000000, the following message is prompted: “Too many results, please refine 
your search" 

 

 

 Element Type Selector  

A selector button has been added to the Element Type field on the Search form to allow users to review and select all 
available element types via the prompted Search Element Types form. The Source filter allows element types to be 
filtered using DB types and, for Design DBs, Sub Types. 
 

    
 
2.15.3.1 User Defined Type Groups 

From the Source options list in the Select Element Types form a user may select a User Defined Type Group applicable 
to the current MDB. 
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2.16 Collections 

The Collections form has been revised at AVEVA E3D 3.1 with the following improvements: 

 Show All or Current Collection 

Option buttons have been introduced to the Collections form to allow a user to control the visibility of All Collections 
or the Current Collection.  
 

 

 Add to Collection 

An additional option has been added to the (Model) Explorer right-click context menu to add hierarchy elements to 
the current collection.  
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 Action on Filtered List  

The Action button in collections utility allows the user to apply an expression on the complete list of selected collection 
elements or on a filtered list.  
 

 

 Select on Canvas 

In the AVEVA E3D Draw module the Select on Canvas option is now available via a right-click context menu in the 
Collection form results grid.  
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2.17 Copy 

 Copy from DIST / ID result to clipboard 

In AVEVA E3D Model and Draw modules the result of the canvas command DIST and ID may be copied to clipboard via 
an introduced tile option in the context editor. The displayed description/output is copied to the system clipboard as 
a plain text so that it may be used in other applications. 
 

             
 

In both cases the current DIST or ID operation will not be released, ensuring the user can still manage the previous 
result, change target point or exit. 

 

2.18 Paste 

 Paste to alternative Owner 

In the AVEVA E3D Model module the individual Copy and Paste functions have been extended to allow a user to paste 
an identified object under a new owning element using an element pick on the Model or Draw Explorers.  The option 
is accessed via the Context Editor option Owner tile.  

 
For example, to paste an equipment element into a different ZONE 
 

 
 

If the picked owning element is not valid, an appropriate message window is displayed. 
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2.19 Savework 

 

The Savework from has been redesigned at AVEVA E3D 3.1 to encourage the use 
of session comments and allow the unclaim of elements. 
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3 Model 
The AVEVA E3D 3.1 Model module facilitates the creation, modification and checking of the full-sized design model in 
a fully interactive 3D environment. The model can be formed using imported geometry, reference laser data and 
discipline specific design functions and tools. Component selection is provided through Specifications that dictate 
which Catalogue Components can be used. A wide variety of diagnostic tools, such as clash and design checkers are 
available, and a flexible reporting capability can be used to produce a wide variety of design documents. 
 
The following sections outline the Model user interface and key developments at AVEVA E3D 3.1. 
 

Please refer to the AVEVA E3D 3.1 User Documentation for detailed information on the new features described 
and the AVEVA E3D 2.1 release documentation for information on functionality introduced to AVEVA E3D 2.1. 

 

3.1 User Interface & Applications 
Introduced at AVEVA E3D 1.1, Model (and Draw) utilises a series of tabs displayed at the top of the application window.  
 
The layout of the tabs has been reviewed at AVEVA E3D 3.1 to support new functionality and to promote an intuitive, 
efficient workflow. For example, the organisation of the discipline tabs offers user friendly access by presenting the 
same groups in the same order for common tasks like Create, Modify and Delete: 
 

 
 
A brief description of each general and discipline tab follows: 

 Home 

 
 
The HOME tab is the starting point on entry to Model and provides access to commonly used tools to modify elements 
and to check model data. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further details of the available options. 

 

 Project 

 

The Project menu or ‘backstage area’ 
provides access to several key commands and 
facilities including the common AVEVA E3D 
commands Save Work, Get Work, Help, 
Modules and Exit. 

 

Group Create Group Modify Group Delete 
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The Options menu option updates the Project area to display an Options area. This area may be utilised to tailor the 
Model application to the user’s preference by specifying general Display, View, Modelling and Discipline options. At 
AVEVA E3D 3.1 the Project area has been extended to support several developments including the introduction of a 
configuration to allow Positionig with Respect to Grid. 
 

Please refer to AVEVA E3D 3.1 User Documentation and Chapter 4 Model: General Interactions for further 
information on the use of the Project tab. 

 View 

 
 
The VIEW tab allows the user to define the parameters (colours, view direction etc.) and content of each 3D View; 
controlling model content through clipping and laser data manipulation. 
 

Please refer to AVEVA E3D 3.1 User Documentation and Chapter 4 Model: General Interactions for further 
information on the use of the VIEW tab.Please refer to Chapter 9 Laser for further information on the use of the 
laser functionality. 

 Tools 

 
 
The TOOLS tab provides methods to check the meta-data of the 3D model, such as volume and weight, and produce 
reports. At AVEVA E3D 3.1 the introduced Assembly Planning capability is accessed via this tab. The tab also offers 
integration with AVEVA NET™ through the Design in Context feature, AVEVA ERM and a number of export/import 
utilities. 
 

Please refer to Chapter 8 General Features for further information on the use of the Assembly Planning and 
AVEVA E3D 3.1 User Documentation for further information on the use of Model tools. 

 Manage 

 
 
The MANAGE tab contains functionality for the management of the project and Model. Model management is aided 
by the control and management of Database elements together with Status Control management and Compare / 
Update integration. 
 
3.1.5.1 Compare/Update 

 
 
The COMPARE/UPDATE tab is prompted on clicking the Compare/Update/Link button from the Integration group of 
the MANAGE tab. 
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The COMPARE/UPDATE tab enables the comparison of the 3D model with data in the Schematic (P&ID) and 
Engineering domains, including AVEVA Instrumentation and AVEVA Electrical. It enables users to understand the 
changes made by other disciplines and departments, which affect their own scope of work with selected changes 
accepted or rejected. 
 

Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of the Model 
management functions and Compare/Update. 

 Design Aids 

 
 
The DESIGN AIDS tab assists the AVEVA E3D user by offering the ability to utilise Reference Grids of various forms, 
Construction Aids and directly annotate the grid and model to aid the overall design. 

 
Please refer to AVEVA E3D 3.1 User Documentation for further information. 

 

 General 

 
 
The GENERAL tab allows the user to create the owning Model hierarchy elements, including Worlds and general 
elements such as Volumes and Areas. The tab also contains Laser demolition functionality that can be applied to laser 
data across model disciplines. 
 

Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 9 Laser for further information on the 
general functions and the use of demolition in the Laser workflow. 

 Draw 

 
 
The DRAW tab enables selected users to view, create and modify drawings via a selection of features from the E3D 
Draw module. 
 

Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 6 Draw in Model for further information 
on the use of Model in Draw functionality. 

 Admin 

 
 
The ADMIN tab enables selected users, who have been granted access to the Admin team, to set up various modelling 
tools such as tool-tips (for the Explorer and 3D graphics), auto-naming, design checker and the Schematic 3D 
Integrator. It can also be utilised to set up administrative data such as system hierarchies, object purpose and links 
between objects. 
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Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Model 
Administrative functionality. 

 Equipment 

 
 
The discipline specific EQUIPMENT tab allows the creation and modification of Equipment elements including the 
management of Penetrations and Associations. 

 
Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 8 Model: General Features for further 
information. 

 Piping 

 
 
The discipline specific PIPING tab (displayed in conjunction with the EQUIPMENT tab) allows a user to create and 
modify piping elements. Further, the user can check the modelled pipework using data consistency tools and in an 
Integrator mode. 
 

Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 8 Model: General Features for further 
information on the Piping discipline and the use of Integrator. 

 HVAC 

 
 
The discipline specific HVAC tab (displayed in conjunction with the EQUIPMENT tab) allows the user to create and 
modify HVAC elements including the management of Penetrations and Spools. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of HVAC. 

 

 Cabling System 

 
 
The discipline specific CABLING SYSTEM tab (displayed in conjunction with the EQUIPMENT tab) allows the user to 
create and modify Cableway elements including the management of Penetrations and Cable Data. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Cableways. 
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 Cable Tray 

 
 
The discipline specific CABLE TRAY tab (displayed in conjunction with the EQUIPMENT tab) allows the user to create 
and modify Cable Tray elements including the management of Penetrations and the import of Cable Tray. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Cable Tray. 

 

 Structures 

 
 
The discipline specific Structures tabs: SECTIONS, PLATES, WALLS AND FLOORS and STAIRS LADDERS AND HANDRAILS 
allow the user to create and modify a series of structural elements. 
 

Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 8 Model: General Features for further 
information on the Structures discipline. 

 Supports 

 
 
The discipline specific SUPPORTS tab allows the user to create and modify Support elements. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information. 

 

 Space Management 

 
 
The discipline specific ARRANGEMENTS tab allows the creation and modification of the space arrangements as well 
as functional area and curve arrangements. 

 
Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 7 Model: Space Management for further 
information. 

 Hull Design 

 
 
The discipline specific HULL DESIGN tab allows the user to create and modify Hull elements. 
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Please refer to the AVEVA E3D 3.1 User Documentation and Chapter 5 Model: Hull Design for further 
information on the use of Hull Design. 

 Common Reference 

 
 
The COMMON REFERENCE tab allows the creation and modification of the common reference elements surfaces, 
curves and points. 
 

Please refer to the AVEVA E3D 3.1 User Documentation, Chapter 5 Model: Hull Design and Chapter 7 Model: 
Space Management for further information on the use of Common Reference functionality. 

 Mining 

 
 
The discipline specific MINING tab allows the user to create and modify Mining elements. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Mining. 

 

 Terrain 

 
 
The discipline specific TERRAIN tab allows the user to create and modify Terrain elements. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Terrain. 

 

 Design Templates 

 
 
The discipline specific DESIGN TEMPLATES tab allows the user to create and modify Design Templates and the 
supporting hierarchy. 

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on the use of Design Templates. 

 

3.2 Message & Status Bar 
Positioned at the bottom of the user interface, the Status and Message bar displays message information, global 
notifications and view and selection options. The Status Bar offers a designer quick access (and feedback) to 3D View 
and modelling aids. For example, the user can display the 3D View Grid and select a variety of positioning options. 
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The status bar has been reviewed at AVEVA E3D 3.1 to account for Draw in Model functionality and a redesign of the 
Object Snap form. 
 

 
Please refer to 4.3 Positioning Elements for further 
information. 

  

3.3 AVEVA PowerCompass™ 

 

The PowerCompass is an intuitive design that allows the user to control the view direction, the 
working plane and to select different coordinate systems. 
 
The PowerCompass can be moved to another area of the 3D view by using the central blue grip 
below the compass. As of AVEVA E3D 3.1, the position of the PowerCompass now persists 
between sessions. 

 
The size / directional sense of the PowerCompass may be controlled via the PROJECT tab Options. 

 

3.4 Contextual Editor 
The Context Editor has been improved at AVEVA E3D 3.1 to allow the specification of the number of decimal characters 
displayed. The definition is set in both Draw and Model via the PROJECT tab, Options menus as illustrated below. The 
default value is 0.  
 

 
 

 
 

3.5 In Canvas Commands & Shortcuts 

 

It is possible to invoke specific commands by entering them directly to 
the 3D View. Alternatively, a shortcut can be used to invoke a command 
e.g. <Ctrl+A> prompts a Select All action. The shortcut actions are, where 
appropriate, aligned with Microsoft Windows standard shortcuts e.g. 
<Ctrl+S> prompts a Savework. 
 
The available commands and shortcuts have been extended at AVEVA 
E3D 3.1 with introduced functionality. 

 
A list of the In-Canvas Commands is presented in Appendix B 
Keyboard Shortcuts & Commands. 
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4 Model: General Interactions 
AVEVA E3D utilises a set of common interactions that ensure the designer’s focus in on the design Model and allow 
design tasks to be completed in an efficient and accurate manner.   
 
The following Chapter will outline general interactions in the Model 3D View and how they have been improved at 
AVEVA E3D 3.1; describing how the View content may be manipulated and controlled. 
 

The key Model interactions described in the following sections are also often shared with the Draw module (Draw 
2D Canvas and 3D View). 

 

4.1 3D View Controls 
The majority of the controls to manipulate the 3D View may be accessed via mouse action, including the PowerWheel, 
and through the VIEW tab user interface. 

 Rotating the 3D View 

 

The Rotation of the model is achieved by holding the middle mouse 
button down and moving the mouse in a direction. By default, the 
rotation mode is set about the Model.  
 
The centre of rotation is determined when the button is pressed. Its 
position is set where the crosshair touches an element in the 3D 
View. The centre of rotation will be indicated by a pink pin. 
 
At AVEVA E3D 3.1 the model may be rotated a complete 360 degree 
rotation. 

 Walk & Fly Modes 

In addition to the classic View Controls, the Walk and Fly Modes allow the user to visualise the 3D Model from a moving 
observer point of view and in perspective mode (with a 90-degree field of view). These functions are ideally suited for 
the navigation of the laser environment on activating the HyperBubble™. 
 

 

To activate or deactivate the modes, the Walk Mode or the Fly 
Mode toggles can be selected from the Control group of the 
VIEW tab. 

 
When Laser models are displayed, enabling the Walk or Fly Modes will activate the HyperBubble™ / Solid Point Cloud 
mode for a increased rendering of the laser data.  
 
In addition to mouse interactions, AVEVA E3D 3.1 introduces the ability to use the arrow keys to walk through the 
model. The following controls are available: 

• Up Arrow   Move forward.  

• Down Arrow  Move backward.  

• Left Arrow   Move left.  

• Right Arrow  Move right. 
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For more information about displaying Laser Data, please refer to Chapter 9 Laser. 
 

4.2 Grips & Feedback 

 

The use of grips in the creation and modification of the 
3D model together with the immediate feedback of the 
preview ghost image are integral to an efficient AVEVA 
E3D 3.1 modelling workflow. In the example here the 
Pump position grip (located at the pump origin) has been 
selected (denoted by red highlight) and the intended new 
position is shown by a ghost preview of the pump (and 
the updated Contextual Editor). 
 

Grips are only made available where the user has 
write-access to modify the selected element. 

 Grip Sizes 

To aid modelling when at a close zoom proximity, grips are no longer dynamically consistent in their size on a zoom 
operation. The conistency of the grip size may be controlled via the PROJECT tab, Options menus. 
 

4.3 Positioning Elements 
The recommended method to modify the position of elements is to move them in the 3D View by either: 

• Using the Editor mode to reposition elements from their origin 

• Using the Move command to specify a start and end position 

Both these methods will require the user to specify positions. It can be just one position for an absolute displacement, 
two positions or a vector for a relative displacement. In all scenarios, the user can specify the position by either: 
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• Entering coordinates directly to the Canvas Contextual Editor. 

• Using the existing geometry of the model by Snapping to graphical objects. 

• Using a combination of Canvas entries and Snapping. 

 Position Format 

In addition to the use of XYZ and ENU coordinates, AVEVA E3D 3.1 allows the positioning of an element in respect to 
a grid using a grid format position / coordinate. 
 
The Coordinates option accessed via the PROJECT tab, Options menus sets the default format to ENU (East, North, 
Up) or XYZ and allows the coordinates to be positioned with respect to a defined reference grid. 
 

 
 
4.3.1.1 Positioning with Respect to Grid  

Reference grid coordinates can be used with plant and marine projects. The Reference Grid from which the 
coordinates are derived is defined through selection from the Reference Grid options list e.g. in the example above 
/PLANT_GRID has been selected.  

• Use Grid Format on Positioning Forms  

Select the checkbox to display positioning forms with coordinates derived from the selected reference grid. 

• Display Positions in Grid Coordinates  

Select the checkbox to display positions across the application, including the coordinates fields in positioning windows, 
with position values measured from the nearest grid. The example displays a referenced plant grid for explicit 
positioning. 
 

 

The plant grid coordinates can be defined using Axis, Row and Elevation 
directions. Positive and negative values can be used. 
 

The position format gadget labels are dependent on each GRIDFA's 
GRDLBL attribute e.g. Axis, Row and Elev. 
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The example displays a referenced ship grid for explicit positioning. 
 

 

The ship grid coordinates can be defined using Frame Positions and 
Longitudinal Positions. 
 

 
The Position Format control has the following features: 

• Display Positions as Absolute Values  

Clicking the option populates the coordinates fields with absolute position values measured using the current 
coordinates system. 

• Display Positions as Offset from nearest Grid Plane  

Clicking the option populates the coordinates fields with position values measured from the nearest grid plane. 

• Pick Position  

Clicking the option populates the coordinates fields with position values measured from a picked position in the 3D 
view. 

• Offset  

 

Clicking Offset modifies the position of the coordinates by an offset 
measured from the original position. Click Return from offset mode to 
exit the offset display. 
 

• Lock  

Toggle to lock and unlock the coordinates in a specified field; the position values cannot be modified. 
 
4.3.1.2 WRT  

 

The With Respect To (WRT) field can be used to define an element from which the 
coordinates are derived. 
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The name of the required element can be modified explicitly; other options are also available: 

• CE   Click to identify the required element in the Model Explorer as the CE.  

• CE Owner   Click to identify the required element in the Model Explorer as the CE’s Owner.  

• World   Click to identify the required element in the Model Explorer as the world.  

• Picked Element  Click to identify the required element as the picked element in the 3D view when prompted. 
 

4.3.1.3 Display positions in grid coordinates 

 
When the option Display positions in grid coordinates is enabled in the backstage, certain positions will automatically 
be formatted with respect to the nearest plane of the selected reference grid. 
 
In CIE operations, this appears as: 
 

 
 
In positioning forms, it appears as: 
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In the Properties Grid, it appears as: 
 

 

 Object Snapping 

 

To activate or deactivate the object snapping, 
press the <F3> key or click on the correspondent 
toggle in the Status Bar. 
 

The object snapping filters may be configured using the Object Snaps & Pline Filters form. The form has been 
redesigned at AVEVA E3D 3.1. 
 

 

The redesigned Object Snaps & Pline Filters form has been arranged 
to present all salient object snaps and (pline filters) in a single form, 
that can be docked to the side of the 3D View canvas for contiuned 
use. 
 
The Graphics section offers filter options to activate graphical snaps 
e.g. Endpoint or Midpoint. 
 
The Elements sections offers filter options to activate the snapping to 
database elements e.g. Item or P-Point. 
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Each snapping filter is associated with a specific snap icon as represented on the Object Snaps & Pline Filters form. 
When the system prompts the user to specify a point, hovering the mouse close to an item included in the selected 
snap filters will display the associated snap icon on the item.  

 

In the example here, the item object snap has been highlighted. 
 
Left clicking when the snap icon is displayed will validate the position 
at the exact location of the Snapping position. 

Also, it is possible to invoke a specific snap filter temporarily to define a specific position regardless of Object Snapping 
being active. This is achieved by right clicking in the 3D View while holding the <Shift> key to invoke the Object Snap 
PowerWheel and selecting an appropriate Object Snap option. 

 

The PowerWheel presents the principal Element Object Snap options such as Item or 
P-Point. 

 

Gesturing to the More tile will open a secondary PowerWheel. The 
secondary PowerWheel presents the principal Graphics Object 
Snap options such as Endpoint or Midpoint. 

   

4.4 Application World 

 

 

Application world elements can be created using the functions 
available via the World options in the Create group of the GENERAL 
tab. 
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5 Model: Hull Design 
The introduced Hull Design application to the AVEVA E3D 3.1 product supports the design of a new hull model, with 
detailing up to a structural design level. The features therein also support the modelling of common global reference 
data i.e. surfaces, curves and points, and the modelling of arrangements used for blocks and scantling data.  
 

 
 

 
 
Please refer to the AVEVA E3D 3.1 User Documentation for further detailed information on the use of Hull Design 

 

5.1 Highlights 
Highlights of the hull design application include the following: 

• Tools and functions to model a common reference model, i.e. surfaces, curves and points. 

• One-click concept - Panels and panel components modelled with few clicks. 

• Detailing by using the Properties Grid. 

• Copied and cloned panels. 

• Panel properties inherited from arrangements. 
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5.2 Interoperability 

 

Sculptured surfaces used in AVEVA Hull & Outfitting 12.1.SP5 can either be converted in 
AVEVA E3D using the function Convert CSURF in the Tools group of the COMMON REFERENCE 
tab or the surface can be released into AVEVA E3D 3.1 using, for example, AVEVA Surface 
Manager. 

 
RSOs created in AVEVA Hull & Outfitting 12.1.SP5 can be converted into polyface surfaces using the Convert RSO 
function in the Tools group of the COMMON REFERENCE tab.  
 

The conversion does not consider any functional data that may have been added to the RSO. 
 

Please note the following interoperability considerations: 

• Polyface surfaces created in AVEVA E3D 3.1 are not available in AVEVA Hull & Outfitting 12.1SP5. 

• Curves and points created in AVEVA Hull & Outfitting 12.1.SP5 are not available for use in AVEVA E3D 3.1. 

• Curves and points created in AVEVA E3D 3.1 are not available for use in AVEVA Hull & Outfitting 12.1.SP5. 

• Space arrangements created in AVEVA E3D 3.1 can be used as read-only in AVEVA Hull & Outfitting 12.1.SP5. 

• Space arrangements created in AVEVA Hull & Outfitting 12.1.SP5 can be used as read-only in AVEVA E3D 3.1. 

• Area and curve arrangements created in AVEVA E3D 3.1 are not available for use in AVEVA Hull & Outfitting 
12.1.SP5.  

• Hull panels created in AVEVA E3D 3.1 are not available for use in AVEVA Hull & Outfitting 12.1.SP5.  

• Hull panels created in AVEVA Hull & Outfitting 12.1.SP5 can be used as read-only in AVEVA E3D 3.1.  

 Interoperability with Hull & Outfitting 12.1.SP5 

The following Hull components can be created in AVEVA Hull & Outfitting 12.1.SP5 and used as read-only in AVEVA 
E3D 3.1 
 

ELEMENT TYPE ELEMENT TYPE 

CPLATE Shell plate 

CSTIFF Shell stiffener 

CSURF Surface 

FEBEAM Finite Beam Element 

FEFRED Finite Free Edges Element 

FESHEL Finite Shell Element 

FETRUS Finite Truss Element 
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HBEAD Planar panel bead 

HBRCKT Planar panel bracket 

HCLIP Planar panel clip 

HCTOUT Planar panel cutout 

HDOPLA Planar panel doubling plate 

HFLANG Planar panel flange 

HPANEL Planar panel 

HPILLR Planar panel pillar 

HPLATE Planar panel plate 

HSTIFF Planar panel stiffener 

 

5.3 Modelling 

 One-click 

The ‘One-click’ concept is to generate visible results in the 3D canvas with as few user interactions as possible. 
 
In the Hull Design application, this means that any hull component will be presented as soon as necessary location 
information is given e.g. once a stiffener trace is available it will be presented. Remaining properties will be derived 
from the functional model or system default values will be used. Once the hull component is presented in the 3D View 
it can easily be updated with correct properties using the Properties Grid. 
 

       

 Project Envelopes 

A hull panel will be automatically bounded when created and later refined by adding bounding limits to the definition. 
A panel located in a surface will first be bounded by the location surface and secondly by envelopes. Panels generated 
in a grid plane or in an absolute coordinate will be automatically bounded by envelopes. 
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The project envelope is by default a box, calculated and automatically defined, from the extensions of the ship grid. 
The project envelope can be changed as required. 
 
In the scenario where the panel is added to a zone which has a connected space (defining the block shape), the space 
will be used as bounding envelope. If no space is available, then the panel is instead bounded by the project envelope. 
 

 
 

This is further explained in the AVEVA E3D 3.1 Hull Design user documentation. 
 

 Locations 

A Hull Panel location can be defined in any plane using absolute coordinates but is preferably defined with reference 
to the common reference model, i.e. a grid position or a surface to get a topological model that can be easily 
maintained and modified. If the location is a surface, then the shape of the surface defines the shape of the hull panel, 
i.e. planar, knuckled or curved. 
 

     

 Definition and Outcome 

A Hull panel consists of a definition that is capturing the designer’s intentions to get all hull components within the 
hull panel topological and easy to change and maintain. The definition can at any time be recreated to get a hull panel 
instance that can be viewed in the 3D canvas. The concept a definition and an outcome (the instance) is allowing for 
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hull panel adaptations to any changes in the surrounding elements, which is making changes to the hull model fast 
and simple. 

 

5.4 Standards 
The Hull Design application in AVEVA E3D 3.1 utilizes built-in standards for profiles, holes, notches, cutouts and clips. 
The built-in standard for profiles, holes and notches is the same built-in standard as in AVEVA Hull and Outfitting 
12.1.SP5. The built-in cutout standard is new to AVEVA E3D 3.1 to support basic slot and lug configuration in structural 
design. 
 

Brackets created in AVEVA E3D 3.1 are standard brackets with user-defined armlengths. A full bracket standard 
is not currently available. 
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6 Model: Draw in Model 
Draw in Model is a new capability within AVEVA E3D 3.1 that enables the usage of Draw functions inside Model, making 
it possible to view, create and modify drawings. A selection of Draw functions is available in a new DRAW ribbon tab. 
 

 
 
Activating Draw in Model will make it possible to see both the 3D canvas and the 2D drawing canvas at the same time.  
 

 
 

6.1 Configuration 
The visibility and use of the Draw tab in Model can be controlled via the following actions: 

• The Model application must have access to Draw (PADD) databases. Read access allows a user to open and view 
drawings and write access allows a user to create and modify drawings. Access and control (module definition) are 
defined via AVEVA Administration for an identified project. 

• The MDB in use must have access to a Draw (PADD) database. To create new drawings or modify existing drawings 
the current user must have write access. 

• The windows environment variable “AVEVA_E3D_DRAWINMODEL” must be set to TRUE when starting Model. This 
can be added to the “evars.ini”, “evars.bat” or “custom_evars.bat” for instance. This will activate Draw in model 
for all projects. In case you would like to activate it only for a specific project this can be done in the 
“project_evars.bat”. 
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6.2 Partial Update Design 
When modelling it is preferred to see all changes made to the model directly in the drawing. To accommodate this, 
without affecting performance, a partial update design functionality has been developed.  
 
The mode is activated via the toggle in the Status Bar and affects the Current Owner View. When changes are made 
to the model only the changed elements are redrawn if they exist in the view or added to the view if newly created, 
allowing for immediate feedback not only in the 3D view but also in the drawing. When all changes have been made 
a full update design can be performed on the view if necessary.  
 

6.3 Properties Grid 
It is possible to select elements in the drawing and see the properties in the Propeties Grid both in Model and Draw. 
This is achieved by selecting one or multiple views and using the IN in-canvas command. All other views will be greyed 
out. To exit this mode, use the OUT in-canvas command or the <Esc> button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



AVEVA E3D™ 3.1 User Bulletin Page 63 of 115 

 

 

 

7 Model: Space Management 
The Space Management application available in AVEVA E3D 3.1 enables the design of functional arrangements; spatial 
as well as area and curve based. These arrangements are the bearers of functional properties (e.g. scantling and 
insulation information) which can be used in, for example, reports and drawings, and in downstream modelling 
activities. To build these arrangements, the ability to create common stable geometrical references in the form of 
points, curves and surfaces is also available in this application. The functionality made available through the 
arrangements can be used for 3D coordination as well as automating parts of the modelling work. 
 

 
 

7.1 Highlights 
Highlights of the space management application include the following: 

• Tools and functions to model a common reference model, i.e. surfaces, curves and points. 

• Tools and functions to model space arrangements by subdividing a volumetric envelope into spaces. Add, subtract 
and merge operations allow for creation of complex shapes. Space arrangements are made functional to serve a 
specific purpose e.g. a layout arrangement.  

• Tools and functions to support extraction of model data within a space and calculations on the exact content 
within the space. The results of such calculations are possible to store in the database for further processing and 
reporting. 

• Tools and functions to model area arrangements by subdividing a surface into functional areas and supporting 
merge operations. Area arrangements are made functional to serve a specific purpose e.g. an insulation 
arrangement. 

• Tools and functions to model curve arrangements by subdividing a curve into functional curve branches and 
supporting merge operations. Curve arrangements are made functional to serve a specific purpose e.g. a seam 
arrangement. 

7.2 Interoperability 

 

Sculptured surfaces used in AVEVA Hull & Outfitting 12.1.SP5 can either be converted in 
AVEVA E3D using the function Convert CSURF in the Tools group of the COMMON REFERENCE 
tab or the surface can be released into AVEVA E3D 3.1 using, for example, AVEVA Surface 
Manager. 

 
RSOs created in AVEVA Hull & Outfitting 12.1.SP5 can be converted into PolyFace surfaces in AVEVA E3D 3.1 using the 
Convert RSO function in the Tools group of the COMMON REFERENCE tab.  
 

The conversion does not consider any functional data that may have been added to the RSO. 
 

Please note the following interoperability considerations: 

• Polyface surfaces created in AVEVA E3D 3.1 are not available in AVEVA Hull & Outfitting 12.1SP5. 
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• Curves and points created in AVEVA Hull & Outfitting 12.1.SP5 are not available for use in AVEVA E3D 3.1. 

• Curves and points created in AVEVA E3D 3.1 are not available for use in AVEVA Hull & Outfitting 12.1.SP5. 

• Space arrangements created in AVEVA E3D 3.1 can be used as read-only in AVEVA Hull & Outfitting 12.1.SP5. 

• Space arrangements created in AVEVA Hull & Outfitting 12.1.SP5 can be used as read-only in AVEVA E3D 3.1. 

 

7.3 Model Hierarchy 
The top element of any created arrangements is a world element, specific to the type of arrangement, i.e. if the 
arrangement is a space, area or curve arrangement.  
 
The administrative elements are: 

• SPMSW for space arrangements. 

• FNCAW for area arrangements. 

• FNCCW for curve arrangements. 

 

 

The different world elements can be created using functions in the World creation options 
list in the Create group of the GENERAL tab. 

 

7.4 Modelling Principles 
The modelling of any arrangement is based on the principle of automatic subdivision of an envelope to create a 
cohesive model with no accidental void areas and with fast response on any geographical question, e.g. what is on the 
other side of a space limit. The subdivided model can then be refined by merging or by adding or subtracting elements. 

 Envelopes 

The space arrangement envelope is a closed volume, generated from surfaces and planes forming a closed volume, a 
primitive definition or a space from a space arrangement.  

• The area arrangement envelope is a surface. 

• The curve arrangement envelope is a curve. 

 Automatic subdivision 

The automatic subdivision of the envelope uses elements from the common reference model, i.e. surfaces, planes, 
curves and primitives. Thus, the actual modelling work of the arrangement is performed when creating and modifying 
these common reference elements. 
 

Arrangements, created for different purposes, can share references to the same common reference elements. 
 

 Definition and Outcome 

A functional arrangement is created by several operations: dividing, merging, adding and subtracting. Typically, a larger 
volume is subdivided by surface or grid elements and then further refined by adding or subtracting of other volumetric 
elements. 
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All these operations (and the order of them) represents the definition data of the arrangement. The actual 
arrangement created is the geometrical outcome of the definitions. A change of an arrangement is made by changing 
the definition or by changing the underlying elements that are referenced by the definition data. If an underlying 
surface, used as definition data in one or several arrangements, is changed then a new updated arrangement can be 
presented by a simple recreate operation. 
 

7.5 Using Arrangements 
Arrangements can contain functional data allowing the arrangement to be specialized for a specific function. The pre-
defined set of attributes, described in detail in the AVEVA E3D 3.1 documentation, is based on the type of arrangement, 
which is set on the owning world element.  
 

The type of arrangement is set in the Properties Grid.  
 

 Space arrangements types 

The following are Space Arrangement Types: 

• Generic. 

• Compartment. 

• Layout. 

• PaintingArea. 

• ProductionBlock. 

• Zones. 

 Area Arrangement Types 

The following are Area Arrangement Types: 

• Generic. 

• Scantling. 

• Openings. 

• Insulation. 

• PaintingAreas. 

 Curve Arrangement Types 

The following are Curve Arrangement Types: 

• Generic. 

• DesignSeam. 

• ProfileTrace. 
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 Navigating Arrangements 

Navigation in space arrangements, to programmatically find a space within an arrangement from a given point or to 
find the space on the other side of a space face, is supported through the implementation of pseudo attributes.  
 

The pseudo attributes are described in detail in the AVEVA E3D 3.1 user documentation. 
 

 Calculations  

The space geometry can be used for searching and selecting elements from any discipline. The Search tool is activated 
(as a side pane) from the function Search in the Search group of the Home tab. The tool can be used to search exactly 
within the shape of a given space. Once a selection of elements is available, it can be used for mass calculations.  
 

 
 
The mass property functions: Volume, Area and Weight and Centre of Gravity, can be found in the group Mass 
Properties of the Tools tab. Each of the mass property functions activates a side pane where a space can be referenced, 
and a calculation can be defined to only calculate exactly within this given space.   
 

Calculation results can be stored in the Analysis database using a right-click menu on the calculation result.  
 

 The Analysis database 

 

The Analysis database and read/write access is setup in AVEVA 
Administration. Analysis data, stored in the Analysis database, is 
organized in packages (GENPKG) and folders (GPKGFL). Each element 
has a filter rule that automatically sorts analysis data into the wanted 
package and folder; either created in advanced or automatically 
when storing. Mass property results, calculated within a space, is 
stored in a package automatically created per used space and in a 
folder automatically created for each mass property calculation.  

  
The stored calculation results can be reported on using the Report tool or used by AVEVA Engineering products. 
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8 Model: General Features 
In addition to the principal development areas of AVEVA E3D 3.1 several improvements have been made across the 
Model disciplines, the following Sections outline a few such improvements. 
 

For further details on improvements made at AVEVA E3D 2.1 update releases, please refer to the AVEVA 
Everything3D™ 2.1.0 Fix Release Documentation. 

 

8.1 Assembly Planning 
The Assembly Planning application has been introduced at AVEVA E3D 3.1. The appliaction is aligned with the content 
and functionality found in AVEVA Hull and Outfitting 12.1.SP5. The Assembly Manager provides functionality to 
manage the production breakdown structure of the design and supports the definition of the build strategy; including 
the creation of assembly production information. 
 
Assembly Planning functionality is accessed from the TOOLS tab. 
 

 
 
A typical Assembly Planning (form) session is shown below: 
 

 
 

Assembly Planning is described in detail in the AVEVA E3D 3.1 documentation and training material. 
 

8.2 Piping 
The Piping application has been improved at AVEVA E3D 3.1 with the following functional improvements. 

 Component Editor: Alignment 

The Editor tool in AVEVA E3D has a feature whereby a user can position a component relative (aligned) to a feature; 
including an offset if required.  
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• Align with feature allows a user to align the component currently selected with the Editor with other objects in 
the 3D View such as structural members. Alignment can be aided using the graphical aids where the bottom of the 
pipe and any insulation can be accounted for. 

• Offset from feature mirrors the align feature but further allows the specification of an offset from the identified 
feature.   

Documentation for this functionality can be found in the AVEVA E3D user documentation: Editor > Model Editor 
Handle > Position and Orientate. 

 
At AVEVA E3D 3.1 the described alignment features have also been made available directly from the Pipe application 
Piping Component Editor form. 
 

 

 
The Position Through area of the Modify tab has been updated with changes to the 
behaviour of the Position with a cursor pick button and the inclusion of a new button 
Position with offset.  

• The Position with a cursor pick button now initiates the same functionality as the 
Align with Feature function of the Editor. 

• The new Position with Offset ON/OFF button toggles to specify whether align 
with an offset is applied or not. With a positive toggle the Offset from Feature 
form is displayed on clicking the Position with a cursor pick button. 

              

 Component Editor Form: BoP/ToP Dumbells 

Expanding on the functionality of the Piping Component Editor form to be aligned with the features available with the 
Editor, the Position Thro cursor pick button has been improved to allow for the O.D of the pipe and any applied 
insulation. 
 

 

When indicating a position in the 3D View the corresponding 
Bottom of Pipe / Top of Pipe solution can be selected 
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 Component Editor Form: Use of ‘P’ Key 

 

The Position Through form available at AVEVA E3D 2.1 and displayed when there is 
more than one solution for a selected position, i.e. for non-orthogonal routes, is no 
longer used at AVEVA E3D 3.1. Instead, the user can press the <P> key to cycle 
through the possible solutions.   

 
For example: 

   
 

8.3 Structures 
The Structures application has been improved at AVEVA E3D 3.1 with the following functional improvements. 

 Extend Section to Surface 

The extension function for GENSEC elements has been enhanced to allow the extension point to be defined by a 
surface pick.  
 

 

On invoking the Extension command the context editor presents a 
new option tile to set a surface pick. 
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On selecting the Surface option, the context editor updates to allow surface selection and offers the option, via an 
option tile, to cut the section end parallel or perpendicular to the surface.   
 

 

 Section End Cut Reset 

As part of the Structures application Mitre function, it is now possible to efficiently reset a Section (GENSEC) start cut 
or end cut to square, or ‘perpendicular’. 
 

 

A new button called Perp. Cut has been introduced beneath the Mitre button in the 
Modify group of the SECTIONS tab. 

 
On selecting the option, the button launches a graphical operation requesting the user selects a GENSEC end to apply 
the perpendicular cut to. After selecting the GENSEC start or end the perpendicular cut is applied and the operation 
continues to be available for further selection until dismissed. 
 

       
 

8.4 Equipment  
The Equipment application has been improved at AVEVA E3D 3.1 with the following functional improvements. 

 Primitive Align & Rotate. 

The Align Primitives function enables the alignment of one primitive with another using a graphical operation. The 
operation involves selecting a P-Point from two different primitives. The first primitive is moved and rotated so that 
the two identified P-Points are at the same position, pointed towards each other. 
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The result of the function is identical to the CONNECT command for Primitive Element Connection. 
 
The default orientation of Extrusion and Revolution P-Points may prohibit the intended primitive alignment. 

 
The function is instigated by clicking the Align Primitives button in the Modify group of the EQUIPMENT tab.  
 

 
 
On invoking the function, the user is prompted to Select First P-Point. 

 
P-Points appear as white crosses, and the closest P-Point to the cursor is highlighted for selection. 
 

If two P-Points are coincident, the P-Point with the highest number in the current element is selected. 
 

On P-Point selection, the Select Second P-Point to Align prompt is displayed. A P-Point from two different primitives 
must be selected in each stage of the operation. 
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As seen below, the P-Point of the first primitive is now aligned with the P-Point of the second primitive. 

 

8.5 Supports 

 AVEVA Catalogue: Design Rules 

The AVEVA E3D Supports application is in the process of being updated to enable automated ancillary selection via 
rules. As part of this process the AVEVA Catalogue application Paragon has been updated to demonstrate the tool set 
that will be available for this feature in future releases.  
 

These tools are not intended for production at this time and are provided for demonstration purposes only. 
 

On the SUPPORTS tab, in the Design Rules group six functions have been introduced as shown: 
 

 
 

 

Clicking the Options, Active Profiles, Rule Sets, Ancillary, Structure and Pad 
buttons will result in a Warning form being displayed. With the exception of 
the Ancillary, Structures and Pad buttons, clicking the OK button will display 
the relevant form for reference purposes. 

 
8.5.1.1 Options 

 

The Support Design Rule Options form will allow a user to determine how ancillary selection is 
undetaken in the Supports application.   
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8.5.1.2 Active Profiles 

 

The Support Design Rules Active Profiles will allow a user to set which profiles will be available for 
automatic selection during framework selection. 

 

 
 
8.5.1.3 Rule Sets 

 

The Support Design Rule Sets form will enable a user to setup rule definitions for automated ancillary 
selection. Each rule definition will allow users to define selection behaviour for a variety of pipe, cable 
and HVAC sizes. 
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8.5.1.4 Ancillary 

 

The Supports Ancillary Design Rules form will enable the user to configure how ancillaries are selected 
for each design rule set. The tools will provide precise configuration of how an ancillary is selected for: 

• A general selection case (i.e. the majority of all support placement). 

• Specific cases (i.e. cases in which pipe bores require a more customised ancillary selection). 

• In addition, each rule will be able to be tailored to suit individual specs from the current catalogue. 

 

 
 
8.5.1.5 Structure & Pad 

 

These options have yet to be implemented but will offer rule configuration options to setup 
support framework placement and pad placements. 

  

8.6 Reports 

 Table Separators 

To account for changes in the supporting software it should be noted that at AVEVA E3D 3.1 the dot ( . ) character is 
no longer used as a table separator in the Report tools. It is therefore required to replace dots in field names with an 
alternative character e.g. the underscore ( _ ) character. 
 
Current Example:      Previous Example: 
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9 Laser 
Laser scan data, including photo-realistic Bubble Views™, can be shown with the design model in the 3D views allowing 
designers to take account of the latest information from the construction site. Breaking free of the scanner position, 
HyperBubble™ and Solid PointCloud technology also allows the user to walk or fly though a combined model and laser 
environment. 
 
Key laser features improved upon and introduced in AVEVA E3D 3.1 include: 

• Solid Point Cloud rendering of laser data. 

• Use of multiple XGEOM elements. 

• Extended Highlight options.  

Laser data reproduced with the kind permission of Eaton Corporation Plc. This data has been collected from a 
mock up facility at Eaton’s training centre in Houston that focuses on industrial applications with over 5,000 
products installed.  

 
Please refer to the AVEVA E3D 3.1 User Documentation for further information on laser capabilities in AVEVA 
E3D 3.1. 

 

9.1 Solid Point Cloud 
AVEVA E3D 3.1 introduces an additional mechanism to render point clouds using the Solid Point Cloud. This new 
technique has been developed to build on the previous HyperBubble™ rendering introduced in AVEVA E3D 2.1 and 
acknowledging the growth in unstructured hand held, airborne and photogrammetry data capture devices. The Solid 
Point Cloud rendering style has been developed to allow the fast rendering of the point cloud to the screen. For a 
focused view of specific areas of a point cloud the point rendering is always recommended for the highest fidelity view. 
 

The Solid Point Cloud is a re-indexing of the laser data for rendering purposes, an Administrator is required to 
index the Solid Point Cloud for a point cloud dataset.  As this action is considered an administrative task, the 
indexing of the dataset would require an LFM Server license and installation.  

 
The following images show the same scene rendered as Solid Point Cloud and as the point representation.  The Solid 
Point Cloud resources are generated by the AVEVA LFM Server and not by AVEVA E3D.   
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Like the HyperBubble, resources should be requested from the service provider providing the survey, or 
alternatively contact the AVEVA LFM Support team to request a copy of the LFM Server software. 

 
The WALK and FLY modes when working with point cloud data have been modified to access the Solid Point Cloud.  
Where the rendering is not available, the HyberBubble mode is accessed and finally falling back to the point cloud 
rendering of the survey. 
 

9.2 Multiple XGEOM Elements 
Users interact with survey data in AVEVA E3D using a XGEOM element, this element allows users to interact with data 
stored in the LFM database as if it were in the AVEVA DABACON database. Once the survey data is loaded users can 
visualise, clash and pick the survey.  The AVEVA E3D 2.1 restriction that only 7 surveys (XGEOM) can be opened at any 
one time has been removed at AVEVA E3D 3.1. 
 

It should be noted that the resources of a computer restrict the number of scans that can be loaded into the 
HyperBubble rendering to six. This is aligned with the purpose of the HyperBubble in regard to close proximity 
navigation of the laser data.  

 

9.3 Extended Highlight 
The AVEVA E3D 2.1 product allows users to highlight and mask (preview) volumes of point cloud data, thus aiding the 
communication of updates to existing conditions.  AVEVA E3D 3.1 builds upon this capability to use multiple colours 
for the highlight of laser data. This allows for the display of status management and demolition sequencing of As-Built 
conditions. 
 

 

The user interface has been extended to allow the user to select 
highlight colour that will be applied to the point cloud.  
 
The user interface is accessible both through the View tab and the 
Laser Volume browser. 

 

 

 
Within Model the Laser Volumes interface will only show the 
demolition elements. As users select elements within the Laser 
Volumes the element will be displayed in the main display, they can 
then be selected to highlight the point cloud captured by the element 
or the highlight colour selected.  
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The standard Colour Selector will be displayed. 
 

 

 

On selecting a colour, the selector button will change to the highlight 
colour. 
 
The user can then toggle the highlight on for the element at which 
point the point cloud will display the specified highlight, different 
volumes can be different colours. 
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10 Draw 
The Draw module was introduced at AVEVA E3D 1.1 and further improved at AVEVA E3D 2.1 and 3.1. The module 
covers the generation and management of drawings, primarily those of the 3D model. As found with the Model module 
the main features of the user interface are based on the Microsoft® Office Fluent™ user interface with a ribbon bar, 
status bar and Properties Grid.  
 
Drawing generation is efficient, with rapid generation of views of the 3D model and highly interactive annotation and 
dimensioning. Drawings may easily be output in various formats such as .DXF, .DGN and PDF. 
 
The Draw development at AVEVA E3D 3.1 can be summarised as: 

• Advanced View Options 

Provide the ability to create location defined Views and Marine industry expansion views. 

• Representation Improvements 

Improvements including the ability to manually hatch island geometry. 

• Annotation Improvements 

Improvements to annotation including flexible label annotation points, extendible symbols and symbol 
groups. 

• 2D Drawing 

Provide ability to order primitives and alignment of Views, Regions and annotation. 

• Administration 

Introduced user interface for Line Styles. 

• Export Deliverables 

Provision of multi-export and a new SVG interface. 

 Please refer to the AVEVA E3D 3.1 Draw user documentation for further detailed information on the introduced 
features. 

 

10.1 Draw Transformation 
Visual elements originally created by AVEVA PDMS Draft or AVEVA Marine Drafting must be transformed before being 
viewed or modified by a Draw user in AVEVA E3D 3.1.  
 
The transformation of visual elements such as Sheets, Backing Sheets, Symbol Templates and Sheet Templates is only 
necessary when migrating AVEVA PDMS or Hull & Outfitting 12.1.SP5 project data to AVEVA E3D 3.1 Draw. 
Transformation is not required for new projects created with AVEVA E3D, or for new visual elements created in AVEVA 
E3D Draw. 
 
Once transformation is complete and a Save Work has been applied, it is no longer possible to view or modify the 
sheet using AVEVA PDMS Draft or AVEVA Marine Drafting. Similarly, new sheets created in Draw will not be accessible. 
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One exception to the transformation of Sheets ‘on-the-fly’ is the requirement to ‘refresh’ Overlays. This is not 
required where Overlays are to be transformed as part of a bulk up-front transformation process. Refreshing is 
necessary in order for Overlays to appear correctly in AVEVA E3D Draw sheets. Unlike transformation, a refresh 
does not affect the use of overlays in AVEVA PDMS Draft or AVEVA Marine Drafting in any way. This is important 
when using AVEVA E3D Draw in a mixed project environment. 

 
Please refer to the AVEVA Migration & Interoperability Guide for further information on the transformation 
process from AVEVA PDMS Draft and Marine Drafting 12.1.SP5 to AVEVA E3D 3.1. 

 

10.2 User Interface & Concepts  
In general terms there is a consistent approach to Canvas and 3D View interaction with the Model module. The 
following sections highlight key concepts introduced at AVEVA E3D 3.1. 

 
Please refer to Chapter 4 Model: General Interactions for further information. 

 Open Sheet 

AVEVA E3D 3.1 introduces a new way of opening a drawing called ‘Temporary copy’. A drawing can be opened in this 
mode by selecting the option on the Open button from the Open Sheet form. 
 

 
 
When a drawing is opened as a Temporary Copy it can be edited, but changes can not be saved to the database. When 
a session ends any drawing modifcations in Temporary Copy mode will be lost.  
 
When a drawing is opened in Temporary Copy mode the new Feedback Banner is shown to inform the user. 
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Note that the Feedback banner is also used when Hidden Annotation or Model Reference Check is active. If more 
than one of the modes are active at the same time there is one feedback banner for each of the active modes. 

 Properties Grid 

10.2.2.1 Display Model Element Properties 

Further to the display of Draw specific properties in the Properties Grid, Model elements may be selected in a view 
and the Properties Grid populated with the model element properties. 
 
This is achieved using the IN command (in the Draw canvas) to enable model element selection for the currently 
selected view.  

 
 
Alternatively, a user can double-click on a model element in a View to directly populate the Properties Grid with the 
model properties of a selected element. 

 View Loading Settings 

If the number of entities in a view exceeds a set limit, a thumbnail (bitmap) of the view is displayed in the drawing 
canvas on opening the Sheet (instead of the model geometry). This introduced functionality enables the efficient 
loading of larger drawings.  
 
The example here displays a view where the number of entities does not exceed the set (administrative) limit and 
where the number of entities exceeds the set (administrative) limit. 
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When a thumbnail is displayed the user is unable to access or select the entities in the view.  The view can be loaded 
by making it the current owner i.e. by a double-click within the View boundary.  
 
If no thumbnail exists, which is the case for drawings generated in AVEVA PDMS / Hull & Outfitting 12.1 or previous 
releases of AVEVA E3D Draw, the Views are not displayed when the number of entities in a view exceeds the set limit. 
This is remedied (thumbnail generated) on a Savework upon updating design or simply making the view the current 
owner.  
 
10.2.3.1 View Loading Defaults  

There are three administrative settings available to configure the loading settings. These options are defined via the 
configuration file at the following default location \%Users%\\AppData\Local\Aveva\AVEVA Everything3D\3.1\ 
DrawSettings\Config\config.xml. 
 
The EntityLimit value can be modified to specify a higher or lower entity limit threshold. The default value is 80000. 
 

10.3 View Definition & Drawlist Management 

 

The following methods of View creation may be utilised from 
the View group of the Home tab. 

 
Quick 

Quick view creation allows the user to produce a View directly from the Model 
Explorer to a default representation, scale and format. 

 

Newly available at AVEVA E3D 3.1, the Advanced View types allow the creation of a 
location and mult-location views. There is also an option to create a Marine Expansion 
View. 

 
Model 

From Model view creation allows the user to produce a View from the Model Explorer 
using a 3D view. The View is created to a custom representation, scale and format. 

 
Projection 

Projection view creation allows the user to quickly form a projection of a defined 
orthogonal View. 

 
Region 

Region view creation allows the user to define a scaled area of the Draw Canvas for 
2D drawing. 
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Detail 

Detail view creation allows the user to identify a View and select an area to form a 
Detail View of differing scale and representation. 

 
Section 

Section view creation allows the user to quickly form a projection of a defined 
orthogonal view and form a section plane therein. 

 
Basic 

Basic view creation allows the user to define a simple View for population at a later 
stage by any method e.g. the reference of a pre-defined project Drawlist. 

 Quick View 

10.3.1.1 Centre Point and default Scale 

At AVEVA E3D 3.1 an additional quick view method has been introduced.  The Create Quick View with Specified Centre 
Point and View Scale option creates a quick view with a specified centre point and view scale via the following steps.  

  

 Location Defined View 

The Location Defined View creation method is used to create symbolic views (with an appropriate symbolic view style 
set) at identified locations in the model; using grid locations or other model elements as a reference.  
 

This replaces the Hull View available in AVEVA E3D 2.1 and is available for both plant and marine industries. 
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 Multi-Location View 

This Multi-Location view creation method is used to create (bodyplan style views), these are used on Hull early 
design/classification drawings to validate surface and curve creation. 
 

   

 Expansion View 

This view type is used to create Hull shell expansion views, these are used on early design/classification drawings to 
allow the shell plate arrangement to be viewed; including the shell seam and butt positions. 
 
The Expansion View is different to the other advanced views, in that it is based upon using a surface (SRFSUR) as the 
reference for the view. The view will need to use an Expansion view style, to achieve the desired view. 
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 Drawlist Management – Quick Add 

 

The introduced Quick Add form allows a user to efficiently and easily add 
model elements (by type and within a defined volume) to the currently 
selected view. 
 
It should be noted that the form does not modify the scale or limits of the 
selected view.  

 View Alignment 

 

Alignment of views has been made easier by the 
introduction of automated alignment of view frames. This 
feature works both at view creation and modification 
stages. The alignment is aided by both a visible dotted line 
and a cursor snap to the alignment line. 

 
Please note that the alignment method can also be employed with Symbols and Label annotation.  
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10.4 View Representation 

 Enhance Elements 

The Draw syntax facility has been extended to allow a user to select (and unselect) annotations on the Sheet 
(DRAENHANCE, DRAUNENHANCE). Further, the SOLELY keyword clears all previous selections before selecting the 
defined components. 
 
For example: 

DRAENHANCE SOLELY CE Select the current element and unselect everything else. 

DRAUNHANCE TEXTPRIMITIVE1 STRA1 Unselect TEXTPRIMITIVE1 and STRA1. 

 Highlight Elements 

The Draw syntax facility has been extended to allow a user to highlight (and remove highlight) elements on the Sheet 
(HIGHLIGHT, UNHIGHLIGHT). Further, the SOLELY keyword clears all previous highlighting before highlighting the 
defined components. 
 
Design geometry must be highlighted in a specific view. This defaults to the current owner but can be overridden with 
the IN keyword.  
 
For example: 

HIGHLIGHT CE Highlight the current element in the current view. 

HIGHLIGHT IN /VIEW1 EQUI1 Highlight EQUI1 in VIEW1. 

HIGHLIGHT SOLELY CE ALL STRA Highlight only the current element and all STRA components. 

 Representation of GENSEC Ends 

Further to being available for SCTN elements, the DRGP (Drawing Priority) attribute has been added to GENSEC 
elements at this release to aid Draw to determine how to draw GENSEC ends in hidden-line removed views. DRGP can 
be set (in the Design Database) to any integer value between 0 (highest priority) and 50.  
 
The illustration indicates plan views of four GENSECs meeting at a node point. The top flanges of the GENSECs are 
coplanar and none of the GENSEC ends have been cut back.  
 
(a) the DRGP attributes of all four GENSECs have been left at 0; as a result, DRAW is unable to determine how to draw 
the intersection lines between the GENSECs and so draws the full outlines of all GENSECs.  
 
(b) the DRGP attributes of the four GENSECs have been set as indicated, which confers a priority order on them. As a 
result, DRAW is able to determine the representation that is intended.  
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Note that using this functionality in non-orthogonal Views can produce slightly distorted results. When producing 
the graphics, the SCTNs /GENSECs are 'shifted' slightly in the View direction by an amount relative to the 
SCTN's/GENSECs DRGP value to allow the hidden-line-removal code to function. Distortion is especially likely to 
be noticed if large values of DRGP are used. It is recommended that DRGP values are kept as small as possible 
and preferably less than 10. 

 Hatching 

10.4.4.1 Hatching Islands 

AVEVA E3D 3.1 introduces a new hatching mechanism enabling hatched areas bounded by Draw primitives and/or 
model elements. Moreover, the feature automatically detects islands inside hatched regions, which can be omitted 
through selection. 
 
A typical usage case is as follows: 

• A user invokes the newly introduced operation by entering the ‘FILL’ command. 

• The user selects elements, which can be either entities or design geometry, to be used to bound the required 
hatching area. 

 

• On selection of the entities, the user identifies the area to be hatched from the selected entities by a pick within 
the required area. More than one hatch area can be defined with the same selected elements. In the image below 
two islands have been identified. The created hatch islands are created as standard 2D outlines (OUTL) and can be 
edited with the standard tools e.g. the Properties Grid. 

      

Island detected 

Island detected 
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Please note that it is observed that very small gaps in model element geometry may erroneously identify an area 
as being closed and not hatching will be created. 

 Line Types and Zoom Scale 

At AVEVA E3D 3.1 graphical lines can optionally be made dynamic so that (non-solid) lines appear the same regardless 
of the zoom level.  
 
The option Dynamic Line Styles is available via the PROJECT tab, Options menu (View > Configuration). 
 

 
 

10.5 Dimensions 
Dimensions are calculated directly from the model with the user able to control the format, content and appearance 
of the created dimension. There are four generic dimension types available in AVEVA E3D Draw that allow intelligent 
dimensions to be created. 
 

 

 Vertex Editor Improvements 

An additional button has been added to the Vertex Editor window to allow a user to identify a Vertex via a canvas 
selection.  
 

 
 

The selected vertex is the one nearest to the selection position.  
 

Linear Dimension  
(LDIM) 

Radial Dimension 

(RDIM) 
Angular Dimension 

(ADIM) 
Pitch Circle Dimension 

(ADIM) 
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 Sort Dimensions 

 

Further to the command that has existed in previous releases, a button 
to sort dimension points has been introduced in the Tools group on the 
ANNOTATION tab. 

Dimensions are drawn in the same order as the LDIM member list order. If the elements become out of order, the 
display of the dimensions becomes confused. The situation can be corrected by using Sort Dimensions at dimension 
or dimension point level. The example indicates the effects of the function. 
 

 

10.6 Labels 
Labels are a form of drawing annotation associated with model elements and comprise text and/or graphics. AVEVA 
E3D Draw principally uses template labels, of which there are two variations: 
 

General Template Label (GLAB)  
 

User can adapt the label content and format to a specific purpose. This may 
include the use of Intelligent Text to derive the label content from the 
model. 
 

Symbolic Template Label (SLAB). The label is formed by a pre-defined label template often containing a 
symbol and/or Intelligent Text for a specific purpose. 

 
Labels can be attached to a model element and used to display any attribute of the element. Direct reference to the 
model data, combined with a simple update annotation operation, ensures the annotation reflects the current state 
of the 3D model.  

 Flexible Connection Points 

Flexible attachment points for Symbolic Template Labels (SLABs) are defined in the template. If a template includes 
connection points (SYCNPT), the leader line of a label is positioned to the nearest connection point automatically as 
the label is located. 
 

 Please refer to the AVEVA E3D 3.1 Draw user documentation for further detailed information on the definition 
and use of flexible connection points. 

 Auto Labelling 

The following features have been introduced at AVEVA E3D 3.1 to aid automatic label creation and definition. This 
feature follows the logic of Autotagging regarding tag rule definition but has extended capability in regard to: 

• Multiple rules within a Ruleset. 

• Automatic update with update design. 

• Increased options to place the label in relation to the model e.g. along a p-line and aligned with a specific p-point. 

Annotations for design elements on a view are enabled using the Properties Grid. 
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10.7 Connectors 
The principal purpose of this introduced entity is to, as the name suggests, make a connection between entities and 
annotations that will be preserved when moving or editing them. 
 

  
 
A Connector is built on an OUTL entity and is created using a set of vertices to define its shape.  
 

While the OUTL entity supports curved segments based on ARCs and SPLINEs, Connectors allow only straight 
segments to connect its vertices. Connectors use reference positions – but not only can be attached to other 
entities via references, but it can contain connection points, so any other entities can be connected to it too. 

 
 Please refer to the AVEVA E3D 3.1 Draw user documentation for further detailed information on the introduced 
Connector element. 

 
The Connector operation can be invoked by two methods: using in-canvas command CONNCT or by the button in the 
Draw section of the Draw tab. 
 

        
 
On invoking the Connector option, the user can define a starting point and subsequent connection points. 
 

 
 
Alternatively, a shield vertex can be employed as a point. 
 

 

Unlike standard vertices, shield vertices use only intelligent positioning. Its purpose 
is to create a connection from more than one component position. For example, 
using this feature, the user can attach one CONNCT to others and its shape will be 
generated based upon referenced positions: 

 
Connector shields are not designed to work within views. They can be drawn in regions just like under a sheet.  
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The following status bar options can be utlised to aid connector creation and modification: 
 

 

Direct modification of a connector is aided by several grips. These 
grips are enabled by the Additional grips option.  
 

 
 
 

 
 
 

The Connector orthogonal mode option ensures the path of the 
connector is orthogonal. 
 

 
  
 

 

Connector point routing is controlled by a toggle in the status bar. 
Connector routing creates connection points automatically. The 
angle of the connection points, which is relative to the owner of 
the connection point, defines the direction of the connector 
segment. 

  

 
 

To aid clarity where connectors cross, a user can define jumpings (gaps). Jumpings can be customized with glyphs and 
created according to the order of entity creation; and may also be modified by using a flag in Properties Grid. 
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 Connector specific operation 

There are some operations that are specific to Connectors. 

• HEAL in-canvas command will invoke Connector Heal operation to merge two connectors. 

• CONNCT_SPLIT in-canvas command will invoke a Connector Split operation. After specifying an entity to split, the 
user is able to choose between three options: 

 

 Visual styles 

The appearance of a connector may be determined by the introduced connector Visual Style. 
 

 
 
Connector entity appearance can be further controlled via the Properties Grid.  
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10.8 Symbols 

 Extendible Symbols 

Extendable symbols are indicated and modified by grip points that display as arrows. Objects that are defined as 
repeatable are copied during the process. 
 

 
10.8.1.1 Create Symbol Template with Extensible Symbols  

On creating a Symbol Template (SYTM) element, which is constructed using a set of symbol (SYMB) elements, the 
administrator can specify which SYMB elements can and cannot be repeated. The SYMB elements must first be created 
using individual SYTM elements. The example displays SYMB elements that are created using three SYTM. 
 

 
 
The SYMB elements are then inserted and positioned on a single SYTM element. 

 
 
The SYMB properties can be updated via the Properties Grid. 
 
10.8.1.2 Symbol type 
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• Select Top from the drop-down list to specify a top symbol. The top symbol is not repeated when stretched along 
the Y axis. The top symbol is positioned at the top of the extended symbol.  

• Select Bottom from the drop-down list to specify a bottom symbol. The bottom symbol is not repeated when 
stretched along the Y axis. The bottom symbol is positioned at the bottom of the extended symbol.  

• Select Left from the drop-down list to specify a left symbol. The left symbol is not repeated when stretched along 
the X axis. The left symbol is positioned at the left of the extended symbol.  

• Select Right from the drop-down list to specify a right symbol. The right symbol is not repeated when stretched 
along the X axis. The right symbol is positioned at the right of the extended symbol.  

• Select Repeatable from the drop-down list to specify a repeatable symbol. The repeatable symbols are repeated 
when extended along the X or Y axis. 

 
The SYTM properties can be updated via the Properties Grid. 
 
10.8.1.3 Extensibility 

 
 
The repeat distances for repeatable symbols along the X and Y axes can be defined via the Properties Grid. 
 
The new SYTM and SYMB elements display in the Draw Explorer. 
 

 

 Configurable Scaling 

Symbols are now enhanced so that they can be changed to be scalable in a single axis, both axis or none. This can be 
selected in the Properties Grid (Scale Axis) where only the possible values are listed or via the attribute Scalap. 
 
The grips in the canvas will reflect the scalability so that it is immediately obvious to a user whether a selected symbol 
is scalable or not, and in which direction. 
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Text scaling can be configured separately from the scaling of the symbol. Texts have the new property Scale Text 
(attribute LSCSYM) in the Properties Grid, which is Yes by default but can be changed to No. When set as No the text 
is not changed when the symbol is scaled. The below shows two symbols with the same symbol template, the top 
example is scaled up along the X axis but as can be seen the text is not scaled. 
 

 

 Symbol groups 

DGROUP is a new element type which allows SYMB elements to be grouped together so they can be easily manipulated 
as one element e.g. scaled or moved as one. A DGROUP can also be copied with the standard <CTRL+C> and <CTRL+V> 
operations in the canvas. The new alignment lines, introduced earlier in this document, are also available for groups 
to assist in positioning. 
 

10.9 2D Drawing 
The Draw tab contains functionality pertaining to the creation, measurement and modification of 2D drawing 
elements. 

 
 
2D Primitives may be created at the Sheet level or within a Region. A Region is a type of View and defines a scaled area 
of the Drawing Sheet which can be used for drafting. A Region has a pre-defined, independent scale and can be created 
at any point in the drawing process.  

 Primitive Order in Canvas 

 

Annotation elements can now be ordered in the Draw canvas. To support 
this operation, Send to Back and Bring to Front fucntions have been 
introduced to the Modify group of the DRAW tab. 

 
The images below illustrate the introduced behaviour. In the first image the circle is on top and in the second image 
the rectangle is on top. The outline of the primitive that is not in front will always be shown in the canvas, this is to aid 
selection of primitive.  
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When exported, here to PDF, the outline of the (behind) primitive is obscured by the (front) primitive. 

 

10.10   Draw Administration 

 Line Styles Manager 

To aid the definition of Line Styles in Draw, a Line Styles Manager has been introduced to the ADMIN tab. The form 
allows the Draw Administrator to control the appearance of Line Styles when utilised in a Drawing e.g. line pattern 
and decoration (text/glyph).  
 
Draw is supplied with a default visual style which is initially assigned to lines by default. Further, an Administrator can 
also create and define line styles with a user-defined line style set as a default style. The Preview shapes tab can be 
used to view the line style as various shapes using the currently defined properties. 
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Please refer to the Draw Administrator User Documentation for further information on the definition and 
properties of Draw Line Styles. 

 Visual Styles 

The definition of the View Visual Style has been extended through the introduction of a Default View Properties tab. 
The tab enables the Draw Administrator to modify the default View style properties for Autolabels, view type, hatching 
rule, representation rule and view scale.  
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The values on the Default View Properties tab are not reset when Set all the visual properties of the selected 
objects to default is clicked on the Properties window. The scale value on the Default View Properties tab is only 
used when creating basic views or quick views. When creating a design view, for example, a projection view, the 
scale value is not used. 

 

10.11 Import 

 CAD Import 

 

The CAD import functionality has been revised in this release. Both 
performance and maintainability have been improved, and new functions 
have been added. The new import allows the user to map fill types in order 
to achieve as accurate a result as possible. Also, blocks are now imported as 
symbol elements with a defined and referenced symbol template (SYTM). 
 
An Import Blanking feature has been created to support wipeouts created in 
CAD. Blanking is an attribute of a DRAW entity, creating a closed outline that 
masks underlying objects. The line style is set to none. 

 
When clicking the new Import CAD File button the user is first presented with a dialog that allows a file to be selected 
for import. After selection of a file and selecting open, the main import form is opened. The form has three tabs, 
General Settings, Fill Types Mapping and Line Types Mapping. The general tab has the following settings:  

 

 

• Drawing name: Name of the imported element. The 
default is the name of the file that is being imported. 

• Import as: SHEET is the most commonly used type, but 
it can also be changed to BACKINGSHEET, 
ISOSYMBOLTEMPLATE, OVERLAY, SHEETTEMPLATE or 
SYMBOLTEMPLATE. 

• Import empty blocks: Enabling this option imports any 
block that is defined but empty in the CAD file being 
imported. Imported blocks will be defined as SYMB 
elements and the symbol templates (SYTM) elements 
will be created. 

• Import attribute definitions as text: Import any 
attribute defined in the DWG/DXF file as TEXP 
elements. 

• Automatic size: Unticking this tick box enables the 
drop-down menu, which has a list of all defined paper 
sizes. Selecting a size from this list will import the CAD 
file to this size. 

• Open after import: Disabling this option will only 
import the file without opening the result. 
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10.11.1.1 Mapping Settings 

 

The CAD import allows mapping of fill types and line types to 
allow the highest possible quality. The tabs Fill Types Mapping 
and Line Types Mapping on the import form can be used to 
modify existing mappings or to create new mappings. 
 
The column Document Fill Types is a list of what is found in the 
file being imported, and the Mapped Fill Types is what the fill 
type is mapped to. The entries in the drop-down menus in 
Mapped Fill Types are all fill types that are available in the 
current MDB. 
 

 

10.12 Export 

 Multi Export 

 

 
Multi export has been introduced for easy export. Multiple drawing 
sheets can be selected for export in one action, and as the image 
below demonstrates, drawing sheets can be selected from any part 
of the hierarchy.  
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 PDF Export 

The multi export functionality has the ability to export multiple drawing sheets to a single file when exporting to PDF. 
When the PDF destination is selected the button labelled Multi Export on the export page changes to a drop-down 
button with the selections Export to Multiple Files and Export to Single File.  
 
10.12.2.1  Specify PDF file version  

 

 
The exported PDF file version can now be specified.  

 Plot Styles  

The user interface introduced at AVEVA E3D 2.1 to create and administer Plot Styles has been extended at AVEVA E3D 
3.1 to allow the control of RGB colours. 
 

 

To create or modify Plot Styles, the Plot Styles button is clicked in the Settings group 
of the ADMIN tab. 

 
The Plot Styles form is displayed; listing the existing Plot Styles. The list(s) of actions that comprise the Plot Style are 
displayed in the Plot Style Actions area of the form. In the example below colours in the Sheet are to be transformed 
to a shade of grey (Monochrome) through a colour Action Type. 
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The RGB Mapping dropdown controls the behaviour of RGB colours for the identified 
plot style.  

 
The options are: 

• None: RGB colours are not mapped. 

• Nearest Neighbour: RGB colours are mapped the same way as their closest colour index. 

• Interpolate: RGB colours are mapped according to an approximation of the plot style. 

Please refer to the AVEVA E3D 2.1 User Bulletin for further information and the AVEVA E3D 2.1 Migration & 
Interoperability Guide for advice on the migration of Plot Styles to the Draw database. 

 SVG Export 

The SVG export has been enhanced in forming a SVG file directly. The performance of the export mechanism has been 
greatly improved as a result. The following new features have also been introduced: 
 

 

• Selection of Plotstyle to be used. 

• Selection of Background colour. 

• A scale can be applied to the produced file 

 

 

10.13 Gateways 

 Export: DRWG or SHEE via Explorer 

With the AVEVA IE&D Gateway installed the Publish to AVEVA NET option via the right-click menu on a DRWG or SHEE 
element becomes active for use. 
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Selecting the Publish to AVEVA NET button presents the user with export configuration options. 
 

 
 
Selecting Publish will start export process for the selected DRWG or SHEE. In the case of selecting a DRWG, all the 
child SHEE elements will be processed using the selected configurations. 

 Export: SHEE via Project tab 

To export one or multiple SHEE elements to SVG/AVEVA.NET via the Project tab the AVEVA IE&D Gateway must be 
installed. Without installation, the Export and Multi Export buttons will be disabled. 
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Selecting the Export button prompts the export configurations form. 
 

 
 
Selecting Publish will start export process for the current SHEE element by the IE&D Gateway using the selected 
configurations. 
 
Selecting the Multi Export button prompts selection of multiple SHEE elements via a browser. 
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Appendix A   Keyboard Shortcuts & Commands 
The following shortcut keys and commands may be used in AVEVA E3D 3.1. 

Function Keys 

F1 AVEVA Help 

F2 Clear Canvas 

F3 Object Snap On/Off 

F4 Object Snap Projection On/Off 

F5 Toggle Walk Mode On/Off 

F6 Toggle Fly Mode On/Off 

F7 Grid On/Off 

F8 Orthogonal drawing On/Off 

F9 Grid Snap On/Off 

F10 Polar Tracking On/Off 

F11 Toggle Shaded/Wireline mode 

F12 Dynamic hints On/Off 

General Keys 

Delete Deletes selected elements in 3D View with confirmation 

Tab Navigates between in-canvas input boxes 

Space Locks value in the in canvas input boxes / Repeat Command 

Home or Page Up Navigates to WORL* level in any Explorer 

End or Page Down Navigates to Bottom Level in any Explorer 

Esc 
Exits current CIE Operation /  cancels position input/ removes selection/exits edit 
mode 

Arrow UP Shows In-Canvas command of last used CIE Operation 

Arrow Down Shows available Tile Icons during CIE Operation 

Insert Toggle Feature Highlight function On/Off 

Backspace Removes selection from 3D view 

Enter Confirms position, selects default option, executes command, etc. 

Ctrl + A Select All Elements in the View 

Ctrl + C Copies via Mid Position of all selected element(s)(Clipboard operation) 

Ctrl + E Toggles Distance Snap Mode On/Off 

Ctrl + F Triggers Find/Search form 
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Ctrl + G GETWORK 

Ctrl + I Toggles Property Grid On/Off 

Ctrl + P Print 

Ctrl + S SAVEWORK 

Ctrl + T Toggles Pick Through Translucency On/Off 

Ctrl + V Paste Clipped 

Ctrl + Y Redo 

Ctrl + Z Undo 

Shift + F4 Toggles between Perspective and Parallel modes 

Shift + F7 Toggles between About Model and About an Eye modes 

Shift + Insert Paste Clipped 

Ctrl + Shift + C Copies element(s) with basepoint(Clipboard operation) 

Alt + Left Arrow Pans 3D view towards Left 

Alt + Right Arrow Pans 3D view towards Right 

Alt + Up Arrow Pans 3D view towards Up 

Alt + Down Arrow Pans 3D view towards Down 

Alt + F4 Quit Application 
  

In Canvas Commands (Model) 

Command Description 

AIDARC Invokes function to create AID type Arc 

AIDBIS Invokes function to create an AIDLIN bisecting between two non-parallel AIDLINs 

AIDCIR Invokes function to create AID type Circle 

AIDFIL Invokes function to create filleting AIDARC connecting two non-parallel AIDLINs 

AIDLIN or L Invokes function to create AID type Line 

AIDPOI Invokes function to create AID type Point 

AIDTAN 
Invokes function to create an AIDLIN tangential to two circles which are non-
concentric 

AIDTEXT Invokes function to create AID type Text 
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Command Description 

ANGLE To calculate angle between any two entities 

AREA To create area arrangement 

BRACING To specify bracing gaps for existing diagonal elements or members 

CAMERA Enables to lock view wrt an object. Also disables 3D orbit mode when it is enabled 

CANCEL Cancels any current operation in-progress 

CO or COPY 
Invokes function to copy selected entities with respect to a base point selected 
and also paste them at required locations in a loop 

COPYBASE Invokes function to copy selected entities with respect to a base point selected 

COPYCLIP Invokes function to copy selected entities without any base point 

CONNECT Enables function to connect any two GENSECs 

CUTBASE 
Invokes function to CUT/PASTE selected entities with respect to a base point 
selected 

CUTCLIP Invokes function to CUT/PASTE selected entities 

CURVE To create curve from plane 

D or LINDIM Invokes function to create db type Linear Dimension 

DECKS To create decks 

DELETE To delete selected entities 

DISCONNECT Enables function to disconnect any two connected GENSECs 

DIST or DI To calculate distance between any two entities 

EM or EDITMODE Triggers Edit Mode 

ENDATUM 
Create an ENDATU Fixing at selected End of GENSEC. Specs can be set only for old 
BS Column and Beam type profiles 

EXTEND 
Enables function to extend the end of a structural element to a reference 
element. 

FILLET To create a Fillet between two non-connected structural elements 

FLY Enable FLY mode operation 

FORCETRIM To trim an attached GENSEC to selective Pline of Owning GENSEC 

FOVY 
Enables option to enter new Vertical field-of-view angle(Projection mode should 
be in Perspective to enable this option) 

GENSECDEF Triggers function to set default specification wrt. existing GENSEC 

GFITT_CRE Enable function to create a GENSEC Fitting 

GFITT_MOD Enable function to modify a GENSEC Fitting 

GRIDCY Invokes function to create a new GRID CYLINCER for Radial Grid only in In-Mode 

GRIDID Resets IDs of REFGRDs 

GRIDPL 
Invokes function to create a new GRID PLANE for REFGRD in IN-Mode(Currently 
works for a single REFGRD) 
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Command Description 

ID Queries Coordinate Positions at snapped position 

IN Triggers IN or Include mode 

JMOD Enables user to modify joints on a SECTION 

LCS Invokes operation to change Coordinate system between Local and World 

LINDIMA Invokes function to create db type Aligned Dimensions 

LOOKROUND 
Enables 3D Orbit mode option to look around a locked view in Perspective 
ProjMode 

M or MOVE 
Invokes function to move entities with respect to a base point selected and also 
paste them at required locations in a loop 

MERGE To merge two members of same element type 

MI or MIRROR To mirror any selected Structural Elements by defining a Mirror Plane 

MITRE Enables option to Mitre two ends of GENSECs 

MLABEL Invokes a function that creates a Label in 3D Canvas 

MREDO Enables user to REDO all previous actions or to desired no. of actions 

NEXT To go Forwards through Views 

OUT Trigger OUT mode by exiting IN mode 

OUTALL takes user all the way out 

OSNAPD Triggers Distance Snap Mode function 

P or PAN Enables REALTIME PAN option  

PANARC Enables function to Create a ARC PANEL using three point or two point methods 

PANCIRC Enables function to Create a CIRCULAR PANEL with multiple options 

PANDIR Pans View towards selected PLAN VIEW directions 

PANDISC Enables function to Create a DISC PANEL using Centre+ or two point methods 

PANELSURF To create panel from surface 

PANELPLANAR To create pane from grid plane 

PANELNXTRDISC Creates a Negative extrusion of a PANEL in Circular Shape in 3 different Modes 

PANELNXTRMULT 
Creates a Negative extrusion of a PANEL in Rectangular Shape using Multiple 
Points 

PANELNXTRRECT Creates a Negative extrusion of a PANEL in Rectangular Shape using Two Points 

PANMULT Enables function to Create a RECTANGULAR PANEL with multiple points 

PANOFFSET Enables function to Create a an Offset Perimeter of PANEL with multiple points 

PANRECT Enables function to Create a RECTANGULAR PANEL using two points 

PANRING Enables function to Create a RING PANEL using three point to two point methods 

PASTECLIP To paste any copied or cut elements that are available in current session 

PFITT_CRE Enable function to create a PANEL Fitting 
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Command Description 

PFITT_MOD Enable function to modify a PANEL Fitting 

PL or PLINE Enables function to create a Polyline 

PLAN Set the current View to Plan View mode 

PR or PROPERTIES Open Property Window if not opened already in the application 

PREV To go Back through Views 

PROJMODE Toggles between Projection modes Orthogonal or Perspective 

RADIAL Enables option to create a Radial Grid 

REDO Redo any operation that was previously called back(Performed Undo) 

REFGRD Enables option to create a Reference Grid 

RO or ROTATE Invokes function to rotate any object around any defined axis 

SCALE To Scale a Structural Element by selecting a Base Point 

SECARC 
Creates an ARC GENSEC and also gives multiple options to choose the way they 
are created 

SECCUR 
Creates a Curved GENSEC and also gives multiple options to choose the way they 
are created 

SECRING 
Creates a RING GENSEC and also gives multiple options to choose the way they 
are created 

SECTION 
Creates a Straight GENSEC and gives multiple options to choose the way they are 
created  

SELALL To select all the elements in 3D View 

SPLICE To Splice any Structural Element(s) in multiple ways 

SPLIT To split any Structural Element(s) in multiple ways 

STRETCH To Stretch any Structural Element along a defined path 

SURFACE To create Surface 

SPACE To create space arrangement 

TOWER Enables option to create a Rectangular Tower Grid 

TOWERT Enables option to create a Triangular Tower Grid 

U To Undo any current operation  

UNDO Enables user to UNDO all operation or to desired no. of counts 

WALK Enables user to WALK around a Model 

Z or ZOOM Enables Zoom options 

-VIEW or -V To change any View between Isometric or Orthographic or Plan View 

-PAN or -P PANs view wrt base point selection 

3DO or 3DORBIT Enables 3D Orbit mode 

In Canvas Commands (Primitives) 
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Command Description 

BOX Invokes function to create BOX 

CYLI Invokes function to create CYLINDER 

CONE Invokes function to create CONE 

CTOR Invokes function to create CIRCULAR TORUS 

DISH Invokes function to create DISH 

EXTR Invokes function to create EXTRUSION 

PYRA Invokes function to create PYRAMID 

RTOR Invokes function to create RECTANGULAR TORUS 

REVO Invokes function to create REVOLUTION PRIMITIVE 

SLCY Invokes function to create SLOPING CYLINDER 

SNOU Invokes function to create SNOUT 

NBOX Invokes function to create BOX 

NCYL Invokes function to create CYLINDER 

NCON Invokes function to create CONE 

NCTO Invokes function to create CIRCULAR TORUS 

NDIS Invokes function to create DISH 

NPYR Invokes function to create PYRAMID 

NRTO Invokes function to create RECTANGULAR TORUS 

NREV Invokes function to create REVOLUTION PRIMITIVE 

NSLC Invokes function to create SLOPING CYLINDER 

NSNO Invokes function to create SNOUT 

NXTR Invokes function to create EXTRUSION 

In Canvas Commands (Draw) 

Command Description 

ADIM  Prompts the Annotate > Angular Dimension action. 

ALIGN Prompts Label Alignment operation 

ANGLE  Prompts the Draw > Angle Measure action. 

ARC  Prompts the Draw > Draw Arc action. 

ARRAY Prompts the Draw > Array Form. 

BACK Send an annotation element to the back of the stack 

CANCEL Cancels the current action. 

CHAMFER Prompts the Draw > Modify Chamfer action. 

CIRC Prompts the Draw > Draw Circle action. 
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Command Description 

CLOSE  Closes the current Drawing. 

CLOSEALL  Closes All open Drawings. 

CONNCT Create a connector. 

CONNCT_SPLIT Split a connector into two separate CONNCT elements 

COPYBASE  Prompts the Home > Copy with Base Point action. 

COPYCLIP  Prompts the Home > Copy to Clipboard action. 

CNPTIN Create CNPTIN, Connection Point Instance on e.g. a symbol 

CUTBASE  Prompts the Home > Cut with Base Point action. 

CUTCLIP  Prompts the Home > Cut to Clipboard action. 

DELETE Prompts the Draw > Delete action. 

DIST Prompts the Draw > Distance Measure action. 

DMND Prompts the Draw > Draw Diamond action. 

ELLI Prompts the Draw > Draw Ellipse action. 

ETRI  Prompts the Draw > Draw Equilateral Triangle action. 

EXCEL Prompts the Annotate > Import Excel Sheet browser. 

EXPLODE  Prompts the Draw > Modify Explode action. 

EXTEND  Prompts the Draw > Modify Extend action. 

FILL Prompts the “manual hatching” operation 

FILLET Prompts the Draw > Modify Fillet action. 

FILLETR Prompts the Draw > Modify Fillet with Radius/Trim action. 

FLY Prompts to set Fly mode in 3D view 

FRONT Send an annotation element to the front of the stack. 

GAP Prompts the Annotate > Insert Gap in Dimension / Label action. 

GRIDRULER Prompts Grid Ruler creation operation 

GROUP Create DGROUP element out of identified symbols 

HEAL “Heal” two connectors, join them into one. 

HEXA  Prompts the Draw > Draw Hexagon action. 

ID  Allows identification of Sheet Position. 

IMAGE Prompts the Annotate > Insert Image browser. 

JUMP Manually add jumps to a connector. 

LABEL  Prompts the Annotate > Insert Label browser. 

LAYER  Prompts the Home > Layers form. 

LDIM  Prompts the Annotate > Linear Dimension action. 

LENGTHEN Prompts the Draw > Modify Lengthen action. 
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Command Description 

LWT  Toggles Canvas Line Width Thickness. STYLWLB 

MERGE Prompts the Draw > Modify Merge action. 

MIRROR  Prompts the Draw > Modify Mirror action. 

MOVE  Prompts the Draw > Modify Move action. 

MREDO  Prompts the Home > Redo of Multiple actions. 

MRKP  Prompts the Annotate > Marker Point action. 

NAVIGATOR Prompts the Navigation Window 

NEWVIEW Prompts tooltip to create a basic view 

UNGROUP Remove the DGROUP and place the symbols in the owning element 

OFFSET  Prompts Draw > Modify Offset action. 

OLAY Prompts the Annotate > Insert Overlay form. 

OUTL  Prompts the Draw > Draw Outline action. 

PAN  Allows Pan Navigation of Sheet. 

PANDIR Allows Directional Pan Navigation of Sheet. 

PASTECLIP  Prompts the Home > Paste from Clipboard action. 

PASTEORIG  Prompts the Home > Paste to Original Coordinates action. 

PDIM Prompts Pitch Circular Dimensions 

PICK  Prompts the Pick action. 

PLOTSTYLES Prompts the Home > Plot Styles form. 

PREV  Returns Canvas to previous view. 

PRINT  Prompts the Project > Print area. 

PROPERTIES  Prompts the Home > Property Grid. 

QUADD Open the Quick Add form to quickly and easily add elements to a view. 

QUIT  Quits the application. 

QVPROJ Prompts the Home > Create Quick Projection View action. 

RAY  Prompts the Draw > Draw Ray Line action. 

RDIM  Prompts the Annotate > Radial Dimension action. 

RECT Prompts Draw > Draw Rectangle action. 

REDO  Prompts the Home > Redo of an action. 

REGION Prompts the Home > Create Region action. 

REVISION  REVISION Prompts the Manage > Revision Control form. 

ROTATE  Prompts the Draw > Modify Rotate about Base Point action. 

SCALE Prompts the Draw > Modify Scale action. 

SECV  Prompts the Home > Create Section View action. 



AVEVA E3D™ 3.1 User Bulletin Page 113 of 115 

 

 

 

Command Description 

SELALL  Selects all elements in canvas. 

SETCOLOUR  Sets the Current Colour in the Active Properties. 

SETLT  Sets the Current Line Type in the Active Properties. 

STRA  Prompts the Draw > Draw Straight action. 

STYLES Prompts the Visual Styles form. 

SYMB  Prompts the Annotate > Symbol Selection browser. 

SYCNPT Create a SYCNPT element 

TABL  Prompts the Annotate > Add Table action. 

TANGENT  Prompts the Draw > Draw Tangent action. 

TEXP Prompts the Annotate > Add Text action. 

TOTLENGTH Prompts the Draw > Cumulative Length Measure action. 

TRIM Prompts the Draw > Modify Trim action. 

STRETCH Prompts the Draw > Modify Stretch action. 

U  Prompts the Home > Undo action. 

UNDO  Prompts the Home > Undo of Multiple actions. 

UPDATEDESI  Prompts the Update > Update Design action. 

IN  Select View and type 'IN' - Enters into Design view mode. 

OUT  Exits Design view mode. 

VDETAIL  VDETAIL Prompts the Home > Create Detail View action. 

VLOC Create Location Defined view 

VMLOC Create Multi Location view 

VMODIFY  Prompts the 3D View Tools Tab. 

VPROJ  Prompts the Home > Create Projection View action. 

VSEC Prompts the Home > Create View Section action. 

WALK Prompts to set Walk mode in 3D view 

XLINE  Prompts the Draw > Construct XLine action. 

ZOOM  Allows Zoom Navigation of Sheet. 

3DORBIT Prompts a 3D Orbit operation in 3D View Mode 
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